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Standards

The equipment is tested to the following product standards:

EMC: EN60945 (2002), EN61000-4-2, EN61000-4-3, EN61000-4-4, EN61000-4-5,
EN61000-4-6, EN61000-4-11, IEC60092-101

Environmental: EN60945 (2002), EN60068-2-1, EN60068-2-1, EN60068-2-2, EN60068-2-6,
EN60068-2-30, EN60068-2-52

Ingress protection: IEC60529

Compass safe distance: EN ISO 694
Health and Safety: EN60950, CSA-C22.2 60950

For an updated list of approvals and statements of conformity, these are available

from: www.phontech.net
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The information in this book has been carefully checked and is believed to be accurate. However, no
responsibility is assumed for inaccuracies.

Zenitel AS reserves the right to make changes without further notice to any products or modules
described herein to improve reliability, function or design. Zenitel AS does not assume any liability
arising out of the application or use of the described product.

SAFETY INSTRUCTIONS

ATTENTION

OBSERVE PRECAUTIONS
FOR HANDLING
ELECTROSTATIC
SENSITIVE
DEVICES

This equipment contains CMOS integrated circuits. Observe handling precautions to avoid static
discharges which may damage these devices.
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SERVICE AND WARRANTY

Zenitel warrants that the product sold by Zenitel substantially confirm with said
products written specifications for a period of up to 24 (twenty-four) months
after invoice date. Notice of claims shall be made to Zenitel within 30 (thirty)
calendar days after receipt of the product. The claim must be registered either
online at www.zenitel.com/customer-service/claims or on RMA form provided
by Zenitel through claims@zenitel.com.

a) Delivered batteries are generally not covered by Zenitel warranty terms.

b) Buyer also has an option to extend the 24 (twenty-four) (24) months warranty time at a
separate charge. The details for this are found in the valid pricelist, and has to be settled
before delivery of the products.

¢) The product must have been properly stored, installed and used to claim under the
warranty.

d) Within the warranty period, the Buyer shall give prompt written notice, if any part of the
product is proven defective in material or workmanship, online either at www.zenitel.com/
customer-service/claims or on RMA form provided by Zenitel through claims@zenitel.com.

e) Zenitel shall not be liable to Buyer or third party claims relevant to accidental or improper
use, wrong installation performed by uncertified technicians, from damage to the product,
or from other circumstances beyond Zenitel’s control.

f) The product shall be returned to Zenitel, subject to prior written consent from Zenitel, in
the form of a RMA reference number (Return Merchandise Authorization). The product
shall be returned immediately, and no later than 60 days after RMA reference number has
been received. Returned products in lack of such reference, will not be accepted by Zenitel
and returned to Buyer at Buyer’s cost.

g) The cost of the return shipment is to be covered by the Buyer. Zenitel will cover the cost of
shipment for replacement parts.

h) Zenitel decides whether a defective part shall be replaced, returned to factory for repair or
being repaired onboard the vessel or on site.

i) If repair/change of parts is to be done onboard the vessel or on site, Zenitel shall approve
by certification the company/technician doing the labor on their behalf.

After the repair is done onboard the vessel or on site, Zenitel will, based on the repair
report, decide if the mentioned repair is a warranty matter or not. If it is a warranty
matter, Zenitel will cover labor time up to 4 hours, and spare parts to correct the fault.
Service technician’s preparation, travelling time and travelling expenses, if any, are for the
account of the Buyer.

j) If Zenitel has to deliver new parts to solve a warranty matter before the claimed product is
received for inspection and acceptance, Zenitel will invoice the new part with standard
order terms at shipment, and then issue a credit note when the defective part has been
received by Zenitel and approved as warranty by quality department.

k) Repair or replacement of parts in a configuration done by Zenitel during the warranty
period, has no effect on the expiration of the warranty for a complete project delivery, and
does not give rise to a renewal or extension of the warranty period for the configuration.
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UTILIZATION:
This equipment is not to be disposed in normal waste, but be handled in accordance with
applicable waste disposal regulations in the country where the equipment is used.

1 SYSTEM DESCRIPTION

The Integrated Communication System Phontech 6200 is designed to meet the requirements for
internal communications and shore connections on board ships.

The system is based on the Phontech 6200 and the Phontech 6200R units. These units are 1U in
size, and may be combined into a complete scalable system effortlessly.

The Phontech 6200 units have a built in 2 port fast Ethernet switch for cascading. It supports ring
network for redundancy. One 1U unit supports up to 24 lines. FXS and FXO, 8 wire E&M and UpN
(61xx terminals) lines are supported. The units will support a mix of up to 6 line modules with 4
lines each. Each line is terminated in a RJ45 jack. A typical PABX configuration could be 5 x 4FXS +
1x4 FXO for a total of 20 telephones and 4 trunks. Typical intercom configuration could be
4x4UpN + 4FXO + 4E&M.

A 2x16 LCD character display with switches is provided to view status messages and configure
basic functions.

VolIP trunks and terminals are terminated using the Ethernet connection. Up to 50 VolP (SIP)
registrations per unit are supported. A number of SIP trunk lines are supported on each of the
Phontech 6200 units.

The exchange cabinet is normally located on the ships bridge, or the electronic equipment room.
The intercom stations may be located in locations requiring two way communications, like the
engine room, engine control room, mooring stations, generator rooms etc.

The Phontech 6200 units have been tested and approved according to IEC 60945.

The Phontech 6200 units are backward compatible with Phontech 61xx terminal hardware.
Termination can be directly on the front panel using CAT5e type cable and RJ-45 connectors, or
using 19" patch panels and patch cables.

If using 6200R, a terminal board (4000019813) is required for easy termination. Less overall rack
space is used due to not requiring a 19” patch panel.

p/n 4000087299 v.K



1.1 MAJOR FUNCTIONS

The major functions of the Phontech 6200 system includes:

PABX operation.

Intercom operation.

Public address.

Access to external systems and nets.
Cost effective modular design.
Flexible dual power supply configuration.
Flexible Numbering plan

Call groups

Call hunting groups

Paging groups

Individual paging

Intrusion

Call transfer

Call forwarding

Wake up calls

Who am | / Identification
Automated switchboard

Direct Inward Dialing

Conference bridge

Configurable access control
Redundant power supplies
Self-diagnostic functions

Field upgradeable hardware and software
Programmable priority structure.

Various intercom units for all purposes:

Office types.
Flush mounted.
Weather/ water protected types.

Noisy area compliant types with extra signal device activation and connection for headset

and loudspeaker.

p/n 4000087299 v.K
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1.4 MECHANICAL LAYOUT 6200R
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1.5 ELECTRICAL CONNECTIONS 6200R

1.5.1 AC-DC VERSION
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1.6 STACKING
Multiple Phontech 6200 units communicate using the Ethernet ports LAN1 (25) and LAN2 (26). The
LAN1 and LAN2 ports are connected internally by a built-in Ethernet switch. Interconnecting 6200

units is done by connecting Ethernet patch cables between the LAN ports. Three topologies are
possible. If you have the 6200R, the LAN ports are located at the rear of the unit.

1.6.1 TREE TOPOLOGY, WHICH IS THE SIMPLEST

1.6.2 STAR TOPOLOGY, WHICH INCLUDES THE USE OF AN EXTERNAL SWITCH
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1.6.3 RING TOPOLOGY, WHICH HAS THE ADDED BENEFIT OF REDUNDANCY

The Ethernet connections have a maximum segment length of 100m. If longer segments are

required, repeaters or media converters can be used. This allows for physical separation of multiple
Phontech 6200 units within a single system.

1.7 RACK MOUNTING

6200 variant:
It is recommended to arrange the Phontech 6200 units in pairs with a patch panel in between for

easy patch cable arrangement. Ports 1-24 on upper 6200 unit will connect to the upper connector
row on the patch panel, and the lower 6200 to the lower row.

Allow space for arranging the cables both inside and on the front of the cabinet.

6200R variant:

If you are using Phontech 6200R you do not need the patch panel between the units. For
easy connection, we recommend to use our interface board 4000019813 together with the
6200R. See chapter 3.2.1.3.1 for more information.
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1.8 INSTALLING LINE BOARDS IN THE PHONTECH 6200/6200R

The line boards are installed on the carrier board inside a Phontech 6200/6200R unit. The line boards
are color coded.

Up to 6 line boards can be installed in any order on the carrier board in 6200.
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Line interface board connectors relates to front panel ports in the following way:

Line interface board Ports
1 1-4
2 5-8
3 9-12
4 13-16
5 17-20
6 21-24

Also in 6200R 6 line boards can be installed in any order on the carrier board.

Line interface board connectors relates to line interface board in the following way:

Line interface board Ports on interface board
1 1-4
5-8
9-12
13-16
17-20
21-24

alnblwWN
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1.9 FXS BOARD

The FXS line board supplies 4 lines of traditional analog telephone lines, aka POTS, Plain Old
Telephone Service. The FXS line is connected to terminals 4 and 5 on the RJ-45 jack. Parallel
connection of terminals is possible.

Line voltage  -48VDC

Ring voltage  50VRms

Maximum REN 3

Loop current  25mADC

Signal levels according to ES 203-021
Line impedance according to ES 203-021

Supported terminals

Zenitel 5111, 5111-H, 5113, 5123, Gigaset DA710, ResistTel Ex,
FEP-2010

1.10 FXO BOARD

The FXO line board supplies 4 trunk lines of the POTS type, Plain Old Telephone Service. This
interface is the opposite side of the FXS interface, and is typically used to connect to shore lines,
mobile networks and satellite trunks.

On-Hook Leakage Current 5uA
Minimum line DC current 10mA
Maximum line DC current 60mA
Ringer equivalence number 0.2

Ring voltage frequency range 13Hz-68Hz
Signal levels according to ES 203-021

Line impedance according to ES 203-021

The FXO line is connected to terminal 4 and 5 on the RJ-45 jack

1.11 UPN BOARD
The UPN line board supports 4 lines of Zenitel Digital Intercom (61xx) lines.

Line voltage  +37VDC
Line impedance 110 ohms

The UPN line is connected to terminal 4 and 5 on the RJ-45 jack
The maximum recommended line length is 500m using 0.75 twisted pair ships cable.
Parallel connection of terminals is not possible.

Supported Terminals
Phontech 6110 MklI, 6111, 6112, 6113, 6114, 6123 and 6124

p/n 4000087299 v.K

Page 1-16



1.12 E&M BOARD

The E&M board is typically used to connect systems like PA/GA and VHF/UHF radio paging.

It has two audio/key inputs and two audio/key output.

The audio inputs can be either line level or microphone level with AGC. The keying input accepts dry
closing contacts. The audio output is line level with transformer isolation, they key output is a dry
closing contact.

Output impedance 1500hms

Input impedance 4.7kohms

Nominal line level 0dBu

Maximum line level +3.15dBu

Nominal mic level -34dBu

Maximum mic level -17dBu

AGC range 44dB
6200 variant:

The inputs are connected to the upper row of RJ-45 jacks, the outputs to the lower. The keying
input/output is connected to 3 and 6 on the RJ-45 jack. The audio line is connected to terminal 4 and
5.
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6200R variant:

The inputs are connected to odd-numbered ports, while outputs are connected the next even
numbered port. The audio is connected to lines A/B, while key is connected to lines C/D on the
4000019813. See chapter 3.2.1.3.1 for more information.

1.13 6200/6200R POWER TERMINAL MODULE

When the Phontech 6200 or Phontech 6200R is installed in a cabinet, a common power terminal
module is fitted, for easy termination of the required power supplies, as well as the power failure
outputs. Power failure outputs are dry closing contacts, and are activated when the corresponding
power supply fails.

See chapter 3 for further details.
1.14 TECHNICAL DATA
Supply voltages Universal AC input (110-230VACQ)

DCinput 24V nominal, 18VDC-72VDC
Maximum power

consumption 65W

Size 445mm x 246mm x 44mm (w, d, h)
Weight 2.5kg

Capacity 24 physical lines, 50 registered SIP clients
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2 INSTALLATION
2.1 INSTALLATION GUIDE

The installation should be planned in detail before commencing. The cables should be listed in a
cable plan, with number of pairs etc. The location of each unit in the communication system should
be planned to obtain maximum performance and user availability. The locations of the intercom
stations and telephones with regards to the operators must be taken especially into consideration.
Zenitel strongly recommend the use of junction boxes for the external cable distribution.

2.1.1 CABLE TERMINATION
First, ensure that the cable to be used is according to the Zenitel specifications. See 2.1.8 and 2.1.9
for more details.

2.1.2 GLANDS
The cables enter weather-proof units by means of cable glands. Where cable glands are not supplied
from the factory, the installer must adapt the glands to the actual cable outer diameter. This is to
obtain the specified ingress protection.

2.1.3 FERRULING
The conductors should be ferruled prior to termination when using cage clamp terminals.

2.1.4 MARKING
Each cable is to be marked with cable numbers.
Each conductor is to be marked with the specific termination numbers.
Please note that Zenitel uses plug-able screw terminals in almost all units. This is to make the
installation and service work as easy and durable as possible.

2.1.5 FASTENING
Where applicable, the cables and the conductors shall be clamped to the structure with cable ties.

2.1.6 PRESERVATION
Prior to, during, and after completion of the installation the equipment surfaces are to be protected
against acid holding fluids, pollution, moist, impacts etc. This is in order to avoid damaged
equipment for which Zenitel will claim void warranty.

2.1.7 SCREEN CONNECTION
In order to obtain maximum performance after installation, it is necessary to terminate the cables
and ground the screens in a satisfactory manner. The cables are to be de-isolated by removing
approximately 500mm of the outer insulation. Then the screen braid is cut off approximately 30 mm
longer than the outer isolation. The conductors are to be de-isolated and ferruled before they are
inserted into the terminals. The outer screen is clamped to the cable fixing rails inside of the cabinet.
Cable ties of a conductive type (metal) are recommended for best result.

2.1.8 CABLE REQUIREMENTS
All cables used with the Phontech 6200 system must be of approved ship cable type.

The cables must be:
¢ Individually twisted pairs
e Recommended conductor size is 0.75 mm?
e All cabling in the Phontech 6200 system must be a separate network.
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e DO NOT COMBINE DIFFERENT SYSTEMS IN THE SAME CABLE. THIS IS TO PREVENT
DISTURBANCE AND NOISE CAUSED BY INTERFERENCE.

Between the exchange and intercom / telephones: 1 pair.
If extra signal device / loudspeaker: 1 extra pair for 24 VDC (total 2 pairs)
Power cables: 1 pair + Ground

2.1.9 CABLE REQUIREMENTS FOR ETHERNET
The Ethernet cables must be of specification category 5e UTP or better. Zenitel recommends using
the TIA/EIA-568-B.1-2001 termination scheme. The maximum length of each segment must be
less than 100m.

2.1.10 COMPLYING WITH IMO REQUIREMENTS
The Phontech 6200 system will comply with IMO requirements for two-way voice communication
systems only if the following is adhered to:

e Extensions located on the navigation bridge and ECR must have the "Priority access'
checkbox checked. An alternative is for these extensions to be a member of a class where the
'Priority access" checkbox is checked. This will give these extensions the highest priority in
the system.

e When telephones are mounted in close proximity on the above mentioned locations, the ring
tones on adjacent telephones should be selected so that incoming calls are distinguishable.
See the user manual for the respective telephones for information on how to achieve this.

e The Phontech 6200 system must be connected to both mains and emergency power. At least
one of the power inputs must be connected to a power source capable of supplying the
Phontech 6200 system during blackout.
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2.1.11 COMMISSIONING TEST
The Phontech 6200 shall be configured according to the customer requirement.

Tests to be performed:
e Handbook is delivered and available for commissioning
e Check the installation according to installation instructions
Using the configuration as reference, for each extension check:
e The installed terminal type
e The local extension name and number
e Class membership and priority service
e Group memberships
e If applicable, the hotline extensions
e If applicable, access control
e If applicable PA group memberships
e If applicable Auto answer

For trunk lines:
e Check trunk type
e Check prefix and DID
e Check access control and billing

2.2 NETWORK RECOMMENDATIONS

2.2.1 OVERVIEW
This section describes how the Phontech 6200 system is designed to use an Ethernet network to
communicate with other Phontech 6200 units, VolP telephones and VolP trunks, how to set up the
Phontech 6200 system in a separate network - either physically or via IEEE 802.1q VLANSs as
supported by many modern switches - and some of the precautions that have to be taken into
account when using IEEE 802.3af-2003 Power over Ethernet for VolP telephones.

2.2.2 PHONTECH 6200 NETWORK CONFIGURATION
When setting up the Phontech 6200 units, one must first run through the “First Run Wizard” as
described in Section 2.4.3. The number chosen for the individual 6200/6200R/6202/6202R unit here
will determine a few things, among these the IP-address the unit will use. By default, all Phontech
6200 units will use the 172.16.0.0/16 network block, and the unit that has been set up as number 1
will always run a DHCP server which will serve addresses in the 172.16.1.0- 172.16.255.254 block to
clients. The number and IP address of a unit that has already been set up can be viewed via the front
panel display as described in Section 2.4.4.5.1.
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In the above example diagram, there are three 6200 units arranged in order, as well as several VolP
telephones which receive an IP address from 6200-unit number 1 via DHCP.

By default, each 6200-unit will route external traffic via 172.16.0.254. Also by default, DNS requests
will be sent to 172.16.0.254. If an external VolIP trunk is required, please make sure that the router is
correctly configured to route IP-traffic and to answer DNS requests.
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We recommend installing the Phontech 6200 system in a physically separate network orin a
separate 802.1q VLAN.

2.2.3 INSTALLING THE PHONTECH 6200 IN A SEPARATE NETWORK
Using a physically separate network is the simplest method of installing a Phontech 6200 system. It
allows you to isolate the PBX from the rest of your network at the cost of separate infrastructure.
This is typically the approach taken if there are few to none VolP telephones or trunks in a Phontech
6200 system, as there is little need to share infrastructure in these cases.
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In the above example, three Phontech 6200 units are connected in a redundant ring while being
separate from the main network. Please note that this also implies separate cabling for the VolP
telephones present.

2.2.4 INSTALLING THE PHONTECH 6200 IN A SEPARATE 802.1Q VLAN
It is also possible to install the Phontech 6200 system in a network separated by using 802.1qg VLANSs.
This method allows you to share infrastructure and cabling that would otherwise have had to be
duplicated. A VLAN is a virtual LAN that will in effect act as a completely separate network despite
passing through the same infrastructure and possibly the same cabling; using a VLAN tag to define
which network the traffic belongs to. It is possible to have up to 4096 different VLANSs. Please note
that in order to use VLANSs, you need VLAN-capable infrastructure.
A common way to organize traffic into VLANSs is to separate different independent services into
separate VLANs.
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In the example above, traffic is separated into a “Voice VLAN” (with an ID of 50) and a “Data VLAN"
(with an ID of 60). The “Voice VLAN" is able to use the same infrastructure as the regular “Data
VLAN” by configuring the switches to tag the traffic appropriately depending on the port it is plugged
into. This may be configured by making sure that the port the VolP telephone is placed on has ingress
tag of 50 and the egress traffic is untagged. Similarly, a computer would have an ingress tag of 60 and
the egress traffic is untagged.

It is also possible to allow several VLANSs to share one port, by making sure that at least all but one of
them is tagging egress traffic. In this approach, the end-point must be VLAN-aware in order to
receive any of the tagged traffic. This could be used to share a port between a computer and a VolP
telephone.

For more complex scenarios, please contact Zenitel for a feasibility study.
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2.2.5 USING 802.3AF-2003 POE FOR VOIP TELEPHONES
Power over Ethernet (“PoE”) allows units which supports it to replace the usual “wall wart” power
supplies that are commonly used for most electrical products. To take advantage of this, a PoE-
capable switch must be used, the end-point must support PoE and the length of the cabling between
the two may not exceed 100 meters, as per 802.3af-2003. If cable lengths greater than this is
desired, please consider distributing one or more switches closer to the end-point, make use of a
PoE-capable repeater or use a PoE-injector closer to the end-point.

For PoE, we recommend category 5 cabling or better.
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2.3 CONFIGURATION APPLICATION

2.3.1 PREREQUESITES

2.3.1.1 Requirements
The Phontech 6200 Configuration Application requires as a minimum the following:
- Windows Vista SP1, Windows 7, Windows 10 or later.
At least 1 GHz CPU speed.
At least 512MiB of RAM.
- Atleast 500MiB of free disk space.
- 100 Mbit/s Wired Network Connection.
The recommended setup is:
- Windows 7 or later.
2Ghz dual-core CPU or better.
4GiB of RAM or better.
2GiB of free disk space or better.
100 Mbit/s Wired Network Connection.

2.3.2 INSTALLATION
To install the application, run the supplied installer and follow the instructions given.

2.3.3 STARTING THE APPLICATION
After installation, the application may be found in the "Start"-menu, as “ICS 6200 Configuration
Application”.

Figure 2-1 - Start Menu Entry
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2.3.4 COMMON TASKS

2.3.4.1 Connecting to a Phontech 6200 Network
In order to connect to and configure a Phontech 6200 system, you must connect your computer to

the Phontech 6200 network. Make sure that your computer is set up to automatically acquire
network addresses, and connect your computer to one of the LAN ports on the front of the 6200.
Alternatively, you may connect your computer to the switch used for VolP telephony if applicable.

Figure 2-2 - DHCP Settings

Verify that your computer is connected to the Phontech 6200 network by checking that it has set an
IP-address. Note that the IP-address shown here is in the 172.16.1.0 — 172.16.255.254 range.

Figure 2-3 - IP Address

If you are running Windows Vista, Windows 7 or Window 10, you may receive a dialog asking you
what kind of network you have connected to. All choices are valid.
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2.3.4.2 Making Changes and Saving Them
When making changes to the configuration in the configuration application, it is important to note
that the changes are not applied to the Phontech 6200 system until you choose to send them.
Sending your changes can be done via the toolbar, or via "File -> Send".

Figure 2-4 - Send Configuration

File  Edit Users Classes Groups Tn

Mew Configuration

Load Configuration

Save Configuration to Disk
Save Configuration to Disk as...
Send

Import License

S Y. o il R

Print Extension Layout
Exit

Figure 2-5 - Send Configuration in File-menu
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The configuration can also be saved to disk using the regular "Save" or "Save as..." commands. Note
that this does not imply the "Send" operation - this must be performed separately.

File  Edit Users Classes Groups Tn

Mew Configuration

Load Configuration

Save Configuration to Disk
Save Configuration to Disk as...
Send

Import License

S L - R

Print Extension Layout
Exit

Figure 2-6 - Save Configuration

Please note that if you have just set up users on a new Phontech 6200 Unit or a unit that you have
just installed new line interface boards on, the configuration application will have to perform some
more intrusive set up procedures, which will cause any ongoing calls on the unit to be terminated. A
pop-up dialog box will warn you of this before performing this action.

& 1CS Reboot Required ¥

One or more of the ICS 6200 units requires a reboot for the
changes to be applied. This will cut off any ongoing calls on
this unit.

Do you want to continue?

Yes No

Figure 2-7 - Required Restart of ICS units

Once the send operation has succeeded, the configuration application will notify.

Figure 2-8 - Send OK

2.3.4.3 First Steps
Upon successfully connecting to a Phontech 6200 and starting the configuration application, it will
automatically discover all 6200 units in the network and download the current configuration.
If the system is newly installed (that is, having just completed the "First Run"-wizard as described in
the installation guide), an empty configuration is in effect.
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2.3.4.4 Adding Users
To add users to the system, please use the Add Multiple Users Wizard. It can be started from the

start view or from the menu bar under "Users".

Figure 2-9 - Add Users

Once you have started the wizard, you will be greeted by an introduction describing the wizard you
have just started. Continue the wizard by clicking the 'Next'-button. This will lead you to the page
were you enter the details for the new users.
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Figure 2-10 - Add Users: Extension, Name, Types and Class membership

When you create new users you have to enter the extension number, user name and the interface in
use by this user. The extension number is the number to call if anyone wants to reach this user. The
user name is used as a description in the configuration application and will be displayed as the caller
ID if the dialed phone supports a character display. The interface decides how the phone is
connected physically and which features the user supports. The different interface alternatives are:

- Analog (FXS): The "regular" station interface. Requires an unused port on a FXS line interface.
Please note that Analog telephones do not support paging or alert groups.

- Digital (UpN): The Zenitel proprietary digital interface. Requires an unused port on an UpN
line interface.

- Snom 300: The Snom 300 brand VolP telephone. Allows you to enter a provisioning MAC
address which will be used to automatically configure the telephone. Requires an unused VolP
license.

- SIP: A generic SIP account which may be used for other VolP phones. Requires an unused SIP
license.

It is possible, but optional to assign the new user to one or more classes. These can be useful in
segmenting access to different kinds of features to different sets of users. Classes will be discussed in
"Managing Users with Classes".

One or more rows may be added by clicking the green plus icon. The number of rows added is
determined by the number entered in the input next to the icon. Each new row is automatically
assigned a new extension number based on the previous row and will inherit the user type and class
membership of the previous row by default.
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Given that one or more of the new users are of the FXS or UpN type, you must now choose which
ports to use. You will be presented with a visual representation of the Phontech 6200 system, where
you can pick the desired port on the desired unit. The ports to select are determined by the type of
users you have created. You will be presented with a view of the system once for each technology
that uses the physical ports. The current interface is described in the upper left corner of the page.
The right side of the page lists the users that are to be placed in the system. A blue text means that
this is the user that will be placed with the next click. A gray name means that this user has already
been placed and a black name signals that this user has not been placed yet. Numbers will be
displayed on the visual representation to indicate which user has been selected for any placed port.

Figure 2-11 - Add Users: Port Placement Page

When placing multiple users, the "Auto Populate" function can be a timesaver. This will automatically
pick unused ports for you in a sequential fashion.

If one or more of the new users are of a Snom 300 variant, you must enter the provisioning MAC
address of the handset. This allows the Phontech 6200 system to automatically provision the
configuration to the handset once it is connected.

If you have exceeded all the available licenses for SIP and Snom 300 users you will be notified in the
bottom of the wizard page and you will not be able to add the users. To add more users of this type,
please see the licenses section of this manual.
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Figure 2-12 - Add Users: Adding SIP and Snom 300 Users

Additionally, if one or more of the new users are of a Snom 300 or SIP type, one may select which
6200 unit they shall be registered on. The configuration application will automatically select this,
based on how many VolIP phones are registered on each unit already, but this can be changed here.
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Figure 2-13 - Add Users: Registration Info for SIP and Snom 300

2.3.4.5 Managing Users with Classes

A class is a collection or set of users that may share some properties. It is an optional feature that
may be used to simplify certain parts of the configuration of large systems.
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Figure 2-14 - Adding Classes

Consider a system where a subset of users - let us call them "Officers" — have access to a number of
features - such as paging groups, dialing out over a trunk interface or high priority access to certain
users. If we were to add or remove users from this set of Officers, we would have to manually change
or update the permissions of each of these features - a process which may be error prone or easy to
forget. This may be simplified by creating an "Officer"-class, which holds all of the relevant users. This
class would be the only member which had access to the features in question, and the issue of
adding or removing users from having access to these features is now simply a case of adding or
removing users from this class.

By default, the system contains one predefined class, which holds all users.
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To add classes, please use the "Add Classes Wizard".

Figure 2-15 - Adding Classes
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To assign class membership to users, you may use the "User Properties" or "Class Properties" dialogs
for existing users, or select the desired class when adding new users.

Figure 2-16 - Adding Members to a Class Using "Class Properties”
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Figure 2-17 - Assigning Class Membership in the “User Properties” Window

2.3.4.6 Adding a Group

Groups provide different functionality on a set of users that are members of the group. The

functionality differs on the type of group:

- Call Group: When the group extension is dialed, the group will call all of its members
simultaneously. The member to first pick up the phone will receive the call.

- Call Hunting Group: When the group extension is dialed, the group will dial all of its members
sequentially in a pre-defined order. The first member who picks up the phone will receive the
call.

- Paging Group: When the group extension is dialed, the call will be automatically paged out on
the speakers of the members of the group. This requires paging support on the phones that are
members of the group.

- Alert Group: The alert group allows a sound to be played on the speaker of the members of the
group, based on an external input. This requires an unused E&M input port, as well as paging
support on the phones that are members of the group.
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To add a group, start the relevant group type wizard.

Figure 2-18 - Adding an Alert Group

The first step is to enter a name and optionally a description for the group. Unless the group is an
Alert group, you will also have to enter an extension for the group. If the group is an Alert group, we
will have to select an unused E&M pair to be used as the source of the alert.
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Figure 2-19 - Selecting the Input for the Alert Group

We will then select the members of the group. You may select classes, individual users and, in some
cases, even other groups. If the group you are adding requires paging functionality, only uses which
support this is listed.
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Figure 2-20 - Adding members to the Alert Group. Note that only users which support paging are listed

Please note that the order of the members is significant in the Call Hunting group, and may be
adjusted using the arrow buttons. For all other groups, the order of the members is insignificant.
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Figure 2-21 - Arranging members in a Hunting Group

Once the members have been added, all we need to do is verify that the information we entered is
correct.
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Figure 2-22 - Verifying a new Call Group

2.3.4.7 Adding a Trunk Line

A Trunk Line allows you to connect your Phontech 6200 system to another PBX or the public

telephone system. Different methods may be used to dial out over the trunk or receive calls from the

trunk.

The different types of trunks provided are:

- SIP client: A 6200 unit will register with a remote SIP server and route calls to and from this
server. Requires an unused SIP license.

- SIP server: A 6200 unit will act as a SIP server for a remote client, and route calls to and from this
client. Requires an unused SIP license.

- FXO: Allows you to connect the Phontech 6200 system to an FXS interface of a remote PBX or
what is commonly called PSTN. Requires one or more unused FXO ports.

- E&M Allows you to connect the Phontech 6200 system to an external system providing key and
audio signals. For example, a PAGA system. Requires an unused input/output pair on an E&M
module.

To add a Trunk Line, start the "Add Trunk Line Wizard". The first step is to enter a name and
optionally a description for the new Trunk Line. Once this has been completed, we will have to select
the type of trunk as described above.
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Figure 2-23 - Adding a Trunk Line

Figure 2-24 - Selecting the Type of the new Trunk Line
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If the trunk type is SIP client, you will have to enter the IP-address or hostname of the provider, as
well as the username, password and realm as supplied by your provider. The 6200 drop down defines
which 6200 unit in the network the Trunk Line shall be added to.

The "Behind NAT" checkbox should be checked if the 6200 unit the trunk is added to is behind a
network address translation layer and must traverse this in order to reach the server. If in doubt,
leave this checked. If the remote server uses multiple IP-addresses to initiate calls to the 6200 due to
load balancing, it is possible to resolve all the hostname addresses using the next checkbox. Please
note that if your provider changes their IP-addresses, you must re-send your configuration to the
6200 network in order to regenerate the trunk settings. If in doubt, leave this unchecked.

If the trunk type is a SIP server, you must define the user name, password and realm you have or will
use on the remote SIP client. You must also select which 6200 unit the client will be registered on.

If the trunk type is FXO or E&M, you have to select which port(s) to use. You can optionally select
multiple FXO ports for load balancing.

Figure 2-25 - Selecting an FXO Port

The next step is to select what action to take when an incoming call is detected. The Phontech 6200
can call one or more extensions directly by selecting "Call an extension", give a switchboard-like
greeting by selecting "Switchboard" or use the supplied number to directly call the intended recipient
using "Direct Inward Dialing". Alternatively, incoming calls may be disabled.

Selecting the “Park incoming calls” option when “Call an extension” is selected will change the
behavior of how the incoming call is dealt with. First a preconfigured phone will ring and answer the
incoming call. As the call is answered, the system will notify the one who answered the call that a
parking number has been allocated for the caller. Once the one who answered the call hangs up, the
caller will be placed in the parking slot announced and another user can dial the configured retrieval
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extension and enter the parking room number to retrieve the call. This extension number is
configured in the Phontech 6200 System Settings and if it is already configured it will be displayed
below the checkbox for the parking option. This option can also be changed from the “Incoming Call
Actions” tab in the Trunk Line properties screen.

Figure 2-26 - Selecting which action to take upon incoming calls
Note that the Direct Inward Dialing option is only available for SIP trunk lines.
Unless incoming calls are disabled, you must select which users and/or groups should be reachable

through this trunk. Users or groups who are not selected in this step may not be called from the
trunk, regardless of the selected incoming call action.
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Figure 2-27 - Select which users who should be reachable from incoming calls

We must also define the outgoing behavior. This can either be "Prefix and dial out extension" - which
allows your users to dial out using the trunk with both a prefix and a dial out extension, "Decided by
extension length" - which sends a call over the trunk line if the dialed number is longer than the
configured number of digits. "Dial out extension only" - which only provides a dial out extension for
your users or disabled entirely. Dial out can also be set to "Disabled" if it should not be possible
under any circumstances to call out with this trunk line.

It is also possible to enable call logging on a trunk line. For this option to be active you must have a
6202 Billing Unit connected to your Phontech 6200 network. See more information about this under
the "Configuring storage" and "Call logging" sections.
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Figure 2-28 - Outgoing calls behaviour

Unless dialing out over the trunk is disabled, you must now select the dial out extension, and
optionally prefix. If "Direct Inward Dialing" was selected during choosing the incoming actions, you
must now supply your DID-prefix and fallback number in case we do not have a correct prefix to
send.
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Figure 2-29 - Supply the extension or prefix number to use

Finally, please verify that the information is correct.

Figure 2-30 — Verify trunk settings
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Many additional settings such as restricting access to dialling out over the trunk, different sounds and
other tweaks are changeable from the properties page for a trunk line. This is described in chapters
such as "Access Control", "Call Logging" and "Custom System Sounds".

2.3.4.8 Printing the Configuration
In order to get a hard copy of the configuration, you may use the "Print Extension Layout" function.
This will give you a printout describing the current layout of the configuration, including extension,
type and port number or MAC address / SIP password. All of this is listed per 6200-unit and grouped
into physical extensions and VolP extensions.

File Edit Users Classes Groups 1In
Mew Configuration

Load Configuration

Save Configuration to Disk

Save Configuration to Disk as...

Send

Import License

Eal L. -] DR

Print Extension Layout
Exit
Figure 2-31 - Printing the Configuration

2.3.4.9 Mark as Good
If you are happy with the configuration at this point, it is useful to run the "Mark as Good" function
on the 6200 unit. Please consult the Phontech 6200 Firmware documentation for instructions on how
to run this function, or how to restore a known good image.

2.3.5 LESS COMMON TASKS

2.3.5.1 SIP licenses
To be able to use SIP telephone or Snom 300 telephones in your Phontech 6200 system, you have to
have a SIP license installed. This license will be provided to you by Zenitel AS. To check the current
status of your SIP license you can go to the "Help -> Info" item from the menu bar. If you click the
“Licenses" tab you should see the status of your license. If this tab is grayed out, you do not have any
license installed.
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& Information ? >

Amity Units Licenses Call Forward Do Not Disturb

SIF Licenses

MAC Addresses 00:06:cb:c0:03:85, 00:06:ch:c0:08:f0
Total Number of Licenses 25

Number of Licenses Available 23

Number of Licenses Used 2

Export Information OK

Figure 2-32 - License Information

To acquire a new license from Zenitel AS or upgrade an old one you can use the "Request
License Quote" dialog. This can be found under the "Help -> Request License Quote" menu.

Figure 2-33 - Request License Quote Menu ltem

Fill out the dialog to request the number of SIP licenses you want and click the "Save" button to get
a file that contains all this information. Then send this file to cs@zenitel.com and you will be
instructed on how to proceed with the order.

p/n 4000087299 v.K

Page 2-52



& Request License Quote ? >

This dialog will help you request a quote for further licenses for
your Phontech 6200 system. Please fill in the details, and send

the generated file to support@jotron.com.
VoIP Licenses

Current Number of Licenses 25

License Active v

Used Licenses 2

00:06:ch:c0:03:85
00:06:ch:c0:08:f0

00:06:cb:c0:08:f0
00:06:cb:c0:03:85

Valid MAC Addresses

Current MAC Addresses

Desired Number of Licenses |25 =

E-Mail Contact Address | |

Other Motes

Save Cancel

Figure 2-34 - Request License Quote Dialog

To make sure the license will be correct make sure all Phontech 6200 Units have been connected to
the system

When you receive a license file you must import it to the configuration. Be sure to keep this license
file safe as you will need it again if you want to create a new configuration from scratch for this
system. Go to the "File -> Import License" menu item and select the license file you were provided.

File Edit Users Classes Groups Tn
Mew Configuration

Load Configuration

Save Configuration to Disk
Save Configuration to Disk as...
Send

Import License

PTG EBENEe

Print Extension Layout
Exit

Figure 2-35 - Import License
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If the license file you selected was valid you will be notified about this and you can check the status
of your license under "Help -> Info" as explained earlier.

Figure 2-36 - License Import Successful

2.3.5.2 Access Control
In order to restrict access to certain resources, it is possible to set up Access Control via the

configuration application. Access Control means that only a specific predefined set of users may use
the resource. It is set up using the properties dialog of the resource in question.

In the dialog, simply set up who should have access to the resource.

Figure 2-37 - Access Control for a Group
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Figure 2-38 - Restricting access to a Group
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Figure 2-39 - Viewing the Access Control settings of a Class

Figure 2-40 - Restricting Access to a User
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2.3.5.3 Hotline
Hotline mode is the ability of having a telephone automatically dial an extension upon going off
hook. It is possible to set up on analog or digital users by using the properties dialog of the user in
guestion and opening the hotline tab.

Figure 2-41 - Enabling Hotline for a User

Please note that this means that this user may only reach the recipient(s) specified in the hotline tab
as he or she may no longer dial extensions.

2.3.5.4 High Priority Calls
High Priority Calls is the ability to always be able to reach users regardless if they are already in a
conversation. This functionality is enabled on a specific user or class. It can be turned on by checking
the checkbox titled "This user/class can intrude into other users’ calls". Any user with this enabled
will be able to intrude into other users calls by pressing '1' when queried. Please note that the other
party will be disconnected.
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Figure 2-42 - Enabling High Priority for a User

2.3.5.5 Additional Tools

The “Tools”-menu of the configuration application contains several additional tools for configuration
and management of the Phontech ICS 6200/6202 and associated phones. These tools are described
in the following sections.

Tools Help
System Snom Settings
System UpN Settings
Custom Sound Files
ICS 6200 System Settings
Phontech 6202 Billing Unit Settings
Migrate Configuration

Update System Firmware

a8 ¥:., B

Conference Configuration
c Update Default Extensions
Jﬂ- Network Configuration

Figure 2-43 — Tools-menu

2.3.5.1 Modifying Global Snom Settings
The global Snom settings dialog allows you to change the default settings for all the Snom 300
telephones in your system. Under "General Options" it is possible to change the default tone scheme,
clock format and ring tone. In the "Volumes" section you can change the volume on the ringer as well
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as the volumes of calls in speaker and handset mode. Under the "Other" section you can force the
settings for all phones. This will disallow any user to change any of these settings on the phone itself.

Figure 2-44 - Changing Global Snom Settings

2.3.5.2 Modifying Global UpN Settings
The global UpN settings dialog allows you to change the default settings for the UpN telephones in
your system.
It is possible to change the default ring tone, handset volume, speaker volume, paging volume and
alert volume, as well as setting the default backlight level and the extensions reached by pressing M1
through M3.

The speed dial buttons M1 through M3 can operate in different modes, but only when the
destination extension of a speed dial button is another digital UpN phone. The three modes of
operations are:

e Normal - The button works as a normal speed dial. The number is dialed as if it were entered
manually on the key pad.

e Intercom - The number is dialed and the other end automatically goes off-hook in an
intercom state. This means that the sound will go out on the speaker on the other end and
the external microphone will be enabled. The conversation will therefore go both ways until
the call has been terminated.

e Paging - The number is dialed and the other end will go off-hook in speaker mode but the
microphone will not be enabled. This means that the call will only serve as a page that
cannot be responded to without the performing another call.
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All the speed dial buttons can either be pushed once or held down. If the buttons are pushed the
calls must be terminated by either by putting the handset back on-hook or pressing the ACT key.
If the buttons are held down the call will automatically terminate once the button is released.

Figure 2-45 - Changing Global UpN Settings

2.3.5.1 Custom System Sounds
The Phontech 6200 system allows you to change some of the default sounds and notifications used
in the system. To change these sounds you must go to the "Custom Sound Files" screen found under
the "Tools" menu.

Before any of the default sounds can be changed you must first upload some new sounds. This is
done by clicking the "Add" button on the right side of the "Uploaded sound files" list. This will open a
file dialog where you can select a sound file to upload. The sound file can be either a .wav file or an
.mp3 file. For the best quality they should be in 8000 Hz Mono. When the file us uploaded it is
transcoded to the internal format used in the Phontech 6200 system. You can listen to the result of
the transcode by clicking the newly uploaded file in the list and then click the "Play" button to the
right of it.

After one or more files have been uploaded they can be selected in the drop down boxes to the right
of the page. This will change the sounds in question to the one you have selected. Uploaded sounds
are also used in other parts of the application such as in the Trunk Line properties screen where you
can select the sound that will play when a "Switchboard" configuration is used.
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Figure 2-46 - Custom Sound Files Screen

2.3.5.2 Modifying Phontech 6200 System Settings
The Phontech 6200 System Settings dialog allows you to configure certain system-wide features.
Among these are the “Time”-settings, “SNMP”-settings and the system wide “Analog Phone”
settings.

Using this dialog, it is possible to set the time to a specific time zone and to synchronise the time to
an external NTP-server. This can be useful when you want to synchronise time across multiple
different systems to avoid that their perception of time drifts between them. “Local time” is the
default setting, meaning that the system will use its internal clock to keep track of time. The local
time and date can be set on the Phontech 6200 units using the front panel display.

It is also possible to set the SNMP settings for the Phontech 6200 system in the tab labelled “SNMP
Settings”. The system is capable of supporting both version 2 and 3 of the protocol. By default,
version 2 is enabled. When using SNMP version 2, the community string must be set. By default, this
is set to “public”.
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Figure 2-47 - Phontech 6200 System Settings — Time Settings

Figure 2-48 - Phontech 6200 System Settings - SNMP Settings
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To enable version 3 of the protocol, simply select the correct version from the dialog and enter the
desired login information.

The authentication method, encryption method and security level may be changed from this dialog,
but the defaults should suffice for most cases. When in doubt, leave this unchanged.

Figure 2-49 - Setting up SNMP Version 3

If you wish to receive traps from the Phontech 6200 system, please enable the checkbox and enter a
valid IP-address, optionally followed by a port. The host entered here will receive traps concerning
common hardware failures such as power supply failures, fan failures or earth faults.
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Figure 2-50 - Phontech 6200 System Settings - Analog Phone Settings

System wide settings for analog phones are configured in the “Analog Phone Settings” tab. Here the
settings for the “Flash” function can be changed.

The extension to retrieve calls stored in the incoming trunk line parking lot can be configured from
the “Trunk Line Parking Settings” tab. Here you can input the extension number that must be called
to retrieve the stored calls. Once a user dials this number, he or she will be asked to enter the
parking room number given to the operator who first answered the call. This page will warn if there
are no trunk lines configured with the parking capabilities or if the selected extension is already in
use.
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Figure 2-51 - Phontech 6200 System Settings - Trunk Line Parking Settings

2.3.5.3 Configuring Billing
The Phontech 6202 Billing Unit Settings dialog allows you to configure the storage devices in your
network. This is required to make use of call logging functionality. The dialog can be found under the
Tools' menu.

p/n 4000087299 v.K



Figure 2-52 - Phontech 6202 Billing Unit Settings

Before any call logging setting can be changed, you must first select a storage unit to be used in the
network. This is done in the drop down box in the upper left part of the page view. The other settings
can only be changed after this has been done.

From this screen you can change the username and password used to access the call logging web
interface. You can also enable or disable logging of internal calls as well as whether or not to update
account balances even though balance is not enforced on accounts. This permits accounts to go into
a negative balance. You can also manage the different PINs used by the system if any trunk lines have
enabled call logging with PIN authentication.

To add a new pin, press the green plus icon and a dialog will appear. In this dialog you must enter the
PIN and optionally a description of the PIN. The description can be changed by selecting the PIN in
the list and clicking the notebook at next to the green plus icon. If you want to remove a PIN, click it
and then click the red minus icon.

If you delete a pin number, the balance attached to this pin will be removed and cannot be restored
unless you have an earlier backup from the web interface.
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& Add Pin entry ? *

Enter Pin number:

|1234 |

Enter description:

|0Fﬁcers code| |

Figure 2-53 - New PIN Dialog

The web interface for the storage unit can be access by typing the IP address of the storage unit into
the address bar of web browser. The address is shown in the drop down where you select the unit to
use as your call logging storage device.

2.3.5.4 Call Logging
If a storage unit has been configured, you can configure call logging on your trunk lines. See the

"Configuring Billing" section above.

To configure call logging on a trunk line, right click the trunk line in the left hand tree view and click
"Properties". This will open the trunk line properties page. Go to the "Outgoing Call Method" tab and
find the call logging options at the bottom of the page. There are a few different modes of call
logging that can be enabled and they are as follows:

e No - This will not enable call logging on this trunk line

e Extension based - This will base call logging and billing on the extension that calls the trunk
line. When a user calls through the trunk line the number he was calling from is logged and
any account balance updates are performed against an automatically created account that
matches the phone that was called from.

e Pin based - A PIN based call logging system will ask the user to input a PIN before he can call
out on a trunk line. When a user dials the trunk line either by a dial out extension or a prefix
or any other method he will be asked for the pin before the call goes out. If the user can
enter a valid PIN, the call will be logged with this PIN number and any account updates will
be to the PIN account that was entered. PIN numbers can be configured in the storage
settings. See the "Configure Storage" section above for more information.
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Figure 2-54 - Trunk Line Properties Screen

There are two other options that can be enabled in the call logging options page. If "Enable pre-paid
billing meters" is checked, a user will only be able to make a call if the account he is associated with,
either a PIN or the phone itself, must have a pre-paid balance. If the required balance is available, the
call will proceed as normal however it will only be able to run for as long as the user has available
balance.

The cost rates for different external extensions can be configured in the storage unit web interface.

If "Delay billing by 20 seconds" is checked, then the user gets the first 20 seconds of a call for free.
Depending on the technology that is used to connect the trunk line to the Phontech 6200 system, it
might be required to tick this to avoid unnecessary billed calls because the user in the other end did
not pick up. Some systems indicate that they go off-hook before the other end actually has
answered.

For more details, see “User manual for Phontech 6200 Call Logging interface”

2.3.5.1 Migrate Configuration to Another System
Sometimes it can be useful to use the same configuration on multiple systems. To achieve this, the
configuration must be migrated from one system to another. We will call the previous system A and
the new system B.

The first step is to save the configuration of system A to a file a computer. After the configuration is
saved the computer must be connected to system B. While the computer is connected to system B,

p/n 4000087299 v.K



load up the configuration from system A and enter the "Migrate Configuration" wizard from the
Tools menu.

In the Migrate Configuration wizard you are presented with the view of the current system as well as
the view of the system in the loaded configuration. The system in the configuration can be seen
under "Configured ICSes" (Phontech 6200 units) and the connected system can be found under
"Unassigned discovered ICSes". The lists in both views display the IP addresses of the units as well as
the modules that are or have been inserted in them.

Figure 2-55 - Unassigned ICSes in Migrate Configuration

If the configured and discovered systems are identical in the module configuration you can press the
"Auto assign" button found between the two views. This will try to automatically match the modules
of the configured ICSes and the discovered ones so they map up perfectly.

If the modules do not match, but you still want to use the configuration anyways you must manually
assign which discovered ICS in system B that should take over the role of a configured ICS in system
A. To do this you first click the discovered ICS in the bottom view and then click the configured ICS
you want it to take the role of in the top view and then click the "Assign selected ICS" button to
assign it. The selected discovered ICS should then disappear from the bottom view. Do this for all
configured Phontech 6200 Units.

Only Phontech 6200 units of the same type can be assigned to each other.
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Figure 2-56 - Assigned ICSes in Migrate Configuration

Once all configured Phontech 6200 units have been assigned a discovered ICS you can click "Finish"
to perform the migration. After the migration is done the configuration can be sent to the system as
normal.

2.3.5.1 Upgrading Firmware
It is possible to upgrade the firmware of Phontech 6200 units by using the Phontech 6200
Configuration Application and a new firmware file as supplied by Zenitel. You can upgrade the
firmware of specific Phontech 6200 units by right clicking on the unit in question in the lower left
corner of the application and selecting "Upgrade Firmware". However, in cases where you have
more extensive systems with several 6200 units, it is easier to use the "Update System Firmware"
dialog, as found under the "Tools"-menu.

Upon opening either of these two options, you will be asked to find the new firmware file. Once this
has been done, the application will check that the new firmware is valid and present you with the
version and build date of both the current firmware and the newly selected firmware.

If this information looks valid, press "Ok" to send the new firmware to your 6200 unit(s). The
firmware will be checked for correctness on the Phontech 6200 unit upon receiving it, prior to
extracting it. The process will take a few minutes and the Phontech 6200 unit(s) will reboot upon
completing it.
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& Firmware Information ? >

Current firmware

IC5 #1 - 172.16.0.1
IC5 #2-172.16.0.2

Version: ics6200_1.5
Build date: fr. 23. juni 16:46:56 +0200 2017

Mew firmware

Version: ics6200_1.5

Build date:  fr. 23. juni 16:46:56 +0200 2017
Verified: v

Update Size: 32080 KiB

Figure 2-57 - Information about Current and New Firmware

2.3.5.2 Configuring Conference Rooms
Conference Rooms are special extensions where multiple users may engage in conversations

together. The Conference Configuration dialog allows you to enable conference rooms and configure
the extension used to dial to the conference rooms.

Figure 2-58 - Enabling Conference Rooms
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2.3.6 TROUBLESHOOTING

In the case that you run into some trouble, this section contains some pointers on how to get some
help and how to troubleshoot basic issues.

2.3.6.1 Starting from Scratch with a New Configuration
If the configuration you have created does not fit as well as anticipated, it may be easier to restart
from scratch. This may be done using the "New Configuration" function, which will present you with
a pristine starting point so you can try again. Remember to send the configuration if you want to
reset the configuration of the Phontech 6200 network too.

2.3.6.2 Unable to Send Configuration due to License Error
If you get the error message below when you try to send the configuration that means that the
installed license either does not validate or does not provide enough licenses for the amount of SIP
or Snom 300 phones configured in the system.

F- "

& Errar During Sending (23]

There was an issue when sending the configuration to the ICS6200 system.

The configuration cannot be sent to the system because the attached SIP license
is notwvalid for the number of SIP connections in the system.

Please go to the Help menu and request a license qoute for atleast 2 5P licenses,

Itis also required that all the ICS units in the systern are online before the license
can be validated,

Figure 2-59 - License Error during Send Configuration

For the license to validate correctly, all of the Phontech 6200 units in the system must be powered
on and connected to the network. This can be verified by inspecting the list of Phontech 6200 units in
the lower left corner of the Configuration Application and see that all the status icons are green.

If the license is not valid for the given system or the number of SIP telephones in use, you can
request a new license from "Help -> Request License Quote" as explained in the "SIP Licenses"
chapter.

2.3.6.3 Revert to Known Good
If you created a known good fallback previously, it is possible to restore that state by using the front
panel display of the Phontech 6200 unit. Please consult the Phontech 6200 Firmware documentation
for instructions on how to perform this operation.
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2.3.6.4 Factory Reset
This function will revert the Phontech 6200 unit to its factory state, and remove all configuration,
databases and settings contained on the Phontech 6200 unit. It is possible to perform this using the
front panel display of the Phontech 6200 unit.
Once this has been performed, the Phontech 6200 unit reverts to its factory defaults. This means
that you will have to run through the first run wizard again. Please consult the Phontech 6200
Firmware documentation for instructions on how to perform this operation.

2.3.6.5 Choose Network Interface

This function can be useful if you have multiple network interfaces connected to different networks.
This may cause the configuration application to not be able to discover your Phontech 6200 network.
The dialog present under "Tools -> Network Configuration" allows you manually select the correct
network interface. By doing this, you will instruct the Phontech 6200 Configuration Application to
send discovery requests to the correct network instead of the more generic fallback.

This setting is stored across restarts of the application. The default value is the "Any"-setting.

& Network Configuration ? 4

Interface to use for ICS discoveries:

Any =

Figure 2-60 - Setting a Network Interface

2.3.6.6 Creating an Information Package
If you require additional support for your Phontech 6200 System, please enclose an Information
Package with your support request. The Information Package can be created using the "Help -> Info"
dialog, simply press the "Export Information" button. This will create a single file containing logs from
the application and any Phontech 6200 unit in the network, the configurations of each unit and
information concerning the software versions used for the Configuration Application and each
Phontech 6200 unit.
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& Information ?

Amity Units Licenses Call Forward Do Mot Disturb

Application version v1.5.0 (Jun 28 2017 15:20:27)
Protocol version 1

Compiled for Qt version 4.8.5

Running Qt library version 4.8.5

Export Information OK

Figure 2-61 - Information Window

2.3.6.7 List of allowed separators in names

It is possible to use alphanumeric characters for names in the configuration application, in addition to

the following separators:
- '-"(hyphen)
- "' (comma)
"." (period)
- '+'(plus)
- '&'(ampersand)
- '#' (hash)
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2.4 FRONT PANEL MANUAL

2.4.1 LED INDICATIONS

There are three LEDs found on the left side of the Phontech 6200 unit, providing different
information. From top to bottom, they are the power LED, the info LED and the error LED.
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Figure 2-62 - Phontech 6200 Front View

The power LED will either be red or green, depending on the power supply status of the unit. If both
power supplies are active, the LED will be green. If one of the supplies is down, the LED will be red.
The info LED will show a heartbeat when the unit is running. The frequency of the heartbeat may give
you an indication of the relative load of the unit. The error LED will light up if an error has been
detected. More information regarding the type of error can be seen in the Information-menu.

2.4.2 FRONT PANEL DISPLAY
The front panel display provides navigation buttons on the left side, an LCD-screen for displaying

information and a cancel and enter button on the right hand side. The front panel also includes a
reset button which may be reached by using a safety pin or a similar instrument.

)

A PHONTECH §200 p
['-F 1 ] L
S e

<O O
O O

b

Figure 2-63 - Phontech 6200 Display and Buttons

2.4.3 FIRST RUN WIZARD

Unless the 6200 has been set up previously, it will run a first time setup wizard when powered on.
This wizard will allow you to set the time and date, as well as choose if the 6200 shall be a new one
or a replacement for another.

Fress Enter

Figure 2-64 - First Step of the First Run Wizard

Bdjust clock
and date

Figure 2-65 - Adjusting Clock and Date in the First Run Wizard
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Enter time:
s
1401
e
Figure 2-66 - Entering the Time in the First Run Wizard
Enter date:
o,
2 Jan 2013
o
Figure 2-67 - Entering the Date in the First Run Wizard

If the 6200 is a new 6200, you must select which number it is. The number shall be unique in a given
6200 network, and the first 6200 in a given network must be numbered 1.

PMew |CS57
Mes
Figure 2-68 - Is This a Replacement or a New Unit?
ICS Mumber:
1

Figure 2-69 - Select the Number for this Phontech 6200 Unit

If the 6200 is a replacement for a previous 6200, you may select which 6200 it is a replacement for
among the ones currently missing. Please note that the replacement 6200 must have the same line
modules installed. If this is not the case, the wizard will warn you, but you may still complete it and
reconfigure the unit at your convenience. Once the wizard is completed, the unit will reboot, and can
be configured and used.

2.4.4 MENUS

When running, the display will show the Zenitel logo by default. When this is shown, pressing any
of the buttons on the unit will show the menu system.

Figure 2-70 - The Zenitel Logo, the Default View

You may navigate through the menu system by using the up and down buttons. Enter will select or
activate the currently chosen entry, while cancel will go back to the previously selected entry in the
menu. Use the left and right buttons to select different options found on the same screen.

The PBX units have all the menus mentioned in these chapters while the Storage units only have the
“Information” and “Setup” menus described in chapters 2.4.4.5 and 2.4.4.6 respectively.
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2.4.4.1 Module Overview

" 0O0OONn 000000
. 00000N 000000

Figure 2-71 - Module Overview

This screen gives a quick overview of the current state of the line modules installed. If any UpN
modules are installed, it is possible to see which ports on the front that have telephones connected.

2.4.4.2 Modules

Modules

st
Figure 2-72 - Modules Menu

1: F®S
vF'-:-r'r.5 1-4

Figure 2-73 - Viewing a Specific Module Position

This screen gives more in-depth information about each of the line modules installed, such as the
type of module, the position it is installed in, and which ports on the front correspond to the module
in question. It is also possible to select individual modules in order to see the extension (if any) that

have been assigned to that particular port.
e

Chil: 201

e
Figure 2-74 - Extension for Port 1

2.4.4.3 Snom

S nom
Rt

Figure 2-75 - Snom Menu

The Snom menu allows you to see the Snom telephones configured on this Phontech 6200 unit. It
will show you the extension the Snom telephones are registered under, if the phone has registered
and the MAC-address of the phone.

2.4.4.4 SIP

SIF

R
Figure 2-76 - SIP Menu
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s
Ext: 1001
vHeg: Mo

Figure 2-77 - Viewing a SIP Extension
The SIP menu allows you to see the SIP telephones configured on this Phontech 6200 unit. It will

show you the extension the SIP telephones are registered under and if the phone is currently
registered.

2.4.4.5 Information

InFormation
ot

Figure 2-78 - Information Menu

The information menu contains different options which allow you to view information concerning
the current state of this Phontech 6200 unit.

2.4.4.5.1 Number and IP

-

PMumber and IF
"o’
Figure 2-79 - Number and IP Menu
|5 #1

IF: 172.16.0.1

Figure 2-80 - Viewing the Number and IP of this Phontech 6200

The number and IP menu will display which 6200 this is and its IP address.

2.4.4.5.2 Error Information

L
Error

iy lnFormation

Figure 2-81 - Error Information Menu

Fan Failure
2389 RPH

Figure 2-82 - Viewing an Error — the Fan Speed is Below the Threshold

The Error Information menu provides a human-readable explanation of errors found in the system, if
any. Multiple errors may be displayed and navigated through by using the Up and Down buttons.
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2.4.4.5.3 Version

s

Versian
R

Figure 2-83 - Version Menu
=200 1.0
-- Thu 3 Jan
12:21:37 CET

Figure 2-84 - Viewing the Firmware Version

The Version menu provides the version and build date of the currently running firmware on this

Phontech 6200 unit.
2.4.4.6 Setup
2.4.4.6.1 Adjust Clock and Date

- Bdiust claock
and date

Figure 2-85 - Adjust Clock and Date Menu

Enter time:
s
T2
Rt
Figure 2-86 - Adjust Clock
Enter date:
Ea
4 Dec 2012
Rt

Figure 2-87 - Adjust Date

The Adjust Clock and Date menu allows you to change the time and date on this Phontech 6200 unit.

2.4.4.6.2 Mark as Good

P

Mark as good
ot

Figure 2-88 - Mark as Good Menu
o
Are you sure?

o »es Mo
Figure 2-89 - Selecting the Mark as Good Menu
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The Mark as Good menu allows you to take a copy of the currently running firmware and
configuration and store it as a "Known Good" image in a separate part of the unit. This firmware and
configuration can then be restored using the "Revert to Known Good"-menu at a later date. If you
choose to create a new "Known Good" image using the "Mark as Good" menu, the 6200 will reboot,
and make a copy of the firmware and configuration. After this has completed, the 6200 unit will
reboot into the regular firmware.

2.4.4.6.3 FXO Tuning

Ea
FAO tuninag

R
Figure 2-90 - FXO Tuning Menu

Note: This sub menu is not available on the Storage units as they do not have any line modules.

The FXO Tuning menu allows you to automatically tune several parameters related to the FXO
modules installed in your system. The tuning procedure is designed to help you reduce or eliminate
unwanted echo that may occur when connecting to other telephony systems. Please note that the
tuning procedure will cut off ongoing calls on the unit.

To start the tuning procedure, select the "FXO tuning" option. In order for the tuning procedure to
work, you must supply a digit which will clear the dial-tone on the unit at the other end.

~ Enter digit

iy 0

Figure 2-91 - Entering a single digit to stop the dial tone

The tuning procedure will tune each port of every FXO module that is installed in the Phontech 6200
unit. This process will take a few minutes. After it has completed, the Phontech 6200 unit will reboot,
and the freshly tuned parameters will be applied.

Tuning 14
20% complete

Figure 2-92 - Tuning in Progress

2.4.4.6.4 Factory Reset

P

Factory reset
Rt

Figure 2-93 - Factory Reset Menu
o
Are you sure?

s res Mo

Figure 2-94 - Selecting the Factory Reset Menu

The Factory Reset function allows you to discard all configuration data and settings stored on the
6200 and restore it to a pristine factory state. Once this has been performed, the Phontech 6200 unit
will reboot, and present you with the first run setup wizard.
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2.4.4.6.5 Revertto Known Good

L
Fevert tao

iy known good

Figure 2-95 - Revert to Known Good Menu

s
Bre you sure?

ot e s P o
Figure 2-96 - Selecting the Revert to Known Good Menu

The Revert to Known Good function allows you to return to a previously set Known Good checkpoint
or, if no such point has been created, to the factory defaults. Upon running this function, the
Phontech 6200 unit will reboot and perform the rollback operation. This will take a few minutes.
Once this has been completed, the Phontech 6200 unit will reboot again into the Known Good
checkpoint. A Known Good checkpoint may be restored multiple times.

2.4.4.6.6 Reboot

P

Feboot
o
Figure 2-97 - Reboot Menu

Ea
Sre you sure?

o »es Mo
Figure 2-98 - Selecting the Reboot Menu

The Reboot function allows you to reboot the Phontech 6200 unit. After the Reboot operation, the
Phontech 6200 unit will return to its regular state.

2.5 CALL LOGGING WEB INTERFACE

The Phontech 6200 can be expanded to perform call logging and billing services. For this purpose, the
Phontech 6202, Billing Unit must be hooked up and configured together with the system.

This is described in the separate handbook: Users Manual for Phontech 6200 Call logging Interface
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2.6 PUBLIC ADDRESSIN 6200

An emergency public address functionality can be set up in a Phontech 6200 configuration. This
requires an additional power amplifier 1671 (ref. 3.2.1.3.3), a loudspeaker network and two

Emergency PA units, 6216 (ref. 8.5).

6200 ICS GENTRAL UNIT Eim:o :: % % Hﬂ ﬁ[ﬂ
1671 AMPLIFIER v } it
?EE 1o0v [ﬂ Public address loudspeakers

Line termination

10Qv
Engine control raam

Access panal
6216

2palr (Audio + key) 2pair {Audie + key)

Figure 2-99

The two Emergency PA units 6216’s must be connected and configured to a E&M board (ref. ch 1.12

/ 2.3.4.7) and the termination module (ref ch.1.13).
The amplifier also requires configuration of an E&M board and the connection set up to the

termination module.

2.6.1 ADDING THE AMPLIFIER 1671 TO AN E&M BOARD TRUNK LINE

Add an E&M trunk line for the amplifier 1671

Add Trunk Line
Please enter a name and a description for this trunk line.

Please enter a name and a description for this trunk line

2/9

Name Amplifier 1671 Connection|

Description

Figure 2-100
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Select E&M line type
Add Trunk Line
Flease select the trunk line type.

Please select the type of trunk line you would like to add

SIP Client
3/9
SIP Server
FX0
Figure 2-101

Select E&M port. This port will correspond with specific terminal on the terminal module (ref. ch
3.2.1.3.1)

Figure 2-102

Disable incoming calls. Line in level selection is indifferent in this case
Add Trunk Line

Please choose the action to take when an incoming call is coming aver this trunk line,

Please select the desired action when an incoming call is arriving.

Call an extension
5/9

ralle :.I.':E_. the init e

=1
ol
m
i
i
]
m
fa]
i
m
=1
o
1=}
n}
i
o

Switchboard

Direct Inward Dialing

EM Input Mode
@) Line In Mode

Microphone Mode

Figure 2-103
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Select a dial out method. As this extension is only meant to open the interface and access the
connected amplifier no prefix method is required.

Add Trunk Line

Please choose how we should dial out over this trunk line.

Should dialing out over this trunk line be enabled?

Prefix and dial out extension

o/8 Decided by entered extension length
@) iDial out extension only, no prefix number |
Disabled
Figure 2-104

The system configuration requires a call out extension number. For the Emergency PA functionality,
no extension is basically required. Select an “fictive” extension number out of the normal range.
Add Trunk Line

Select the extension prefix to call to reach an outgeing line over this trunk line.

Enter the extension or prefix to call to dial out, If this number is dialed alone, a new dial tone will be given so the caller
can dial a new external number, If the number is used as a prefix, the rest of the number will be dialed out over the
7/8 trunk line.

Extension 9a9g| &

Figure 2-105

The amplifier 1671 shall be connected to the output port. (ref. ch 3.2.1.3.1)

2.6.2 PREPARING AN EMERGENCY PA GROUP
Add an EMPA Group. This function is only available in the toolbar menu.

Figure 2-106
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As this EMPA group is intended to be accessed by Emergency PA unit 6216 only, no extension is
basically required. Select an “fictive” extension number out of the normal range.
Add EMPA Group Wizard

Basic Information

Group name Emergency Public Address annoucement|

2/4 Group description

Extension number 10000 |5

Figure 2-107

Add the previously prepared Trunk line; “Amplifier 1671 Connection” as a member of this EMPA

group.
Add EMPA Group Wizard
EMPA Destinations
Add the Classes, Users or Extensions this group should call,
3/4 Available Members
4 28 Classes 4 g‘-‘ Trunk Lines
All Users 12 users(s) 4] Armplifier 1671 Connection E&M trunk
Add Selected
Remove Selected

Figure 2-108
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2.6.3 ADDINGA 6216 TO AN E&M BOARD TRUNK LINE AND ACCESS TO THE EMPA
GROUP
Add an E&M trunk line for the 6216

Add Trunk Line

Please enter a name and a description for this trunk line.

Please enter a name and a description for this trunk line

2/9

Mame 5216 Emergency PA Unit #1

Description

Figure 2-109
Select E&M line type

Add Trunk Line
Flease select the trunk line type.

Please select the type of trunk line you would like to add

) SIP Client
39
) SIP Serwer
~) FXO
Figure 2-110

Select E&M port. This port will correspond with specific terminal on the terminal module (ref. ch
3.2.1.3.1)

Figure 2-111

p/n 4000087299 v.K



Select “Call an extension” and “Microphone Mode”
Add Trunk Line

Please choose the action to take when an incoming call is coming over this trunk line.

Please select the desired action when an incoming call is arriving.

@ Call an extension
5/9

Park incoming calls after the initial conversation with the called operator

Switchboard
Direct Inward Dialing

Dizable incoming calls

EM Input Mode

Line In Mode

@ Microphone Mode

Figure 2-112

Add the previously prepared EMPA group “Emergency Public Address announcement” as the
incoming call action for this trunk line.

Figure 2-113
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Then at last disable incoming call as this is not an option for the Emergency PA Unit.
Add Trunk Line

Please choose how we should dial out over this trunk line.

Should dialing out over this trunk line be enabled?
Prefix and dial out extension
7/9
Decded by entered extension length

Dial out extension only, no prefix number

Figure 2-114

Any more 6216, Emergency PA units is added to access this “Emergency Public Address
announcement” group.

AN EMPA GROUP HAS AN OVERALL PRIORITY IN THE SYSTEM AND WILL OVERRIDE ANY
OTHER ACTIONS.
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2.7 PHONTECH 6200 AS PA/GA SPEAKER LOOP

The Phontech 6200 system can be configured as a speaker loop for an existing PA/GA system such as
MPA 1600. The alarm and PA messages will be administered from the PA/GA system and the phones
in the Phontech 6200 system will be used as a speaker loop where the alarm or message will be
played. This requires an E&M connection between the Phontech 6200 and the PA/GA system as well
as telephones in the Phontech 61xx, 62xx or 72xx ranges. The messages from the PA/GA system will
always take priority if configured as outlined in this chapter.

Note: Telephone stations in priority areas cannot be used as a speaker loop because they must
remain available for two way communication in the event of a PA or GA event.

The PAGA systems audio output should be connected to the Phontech 6200 E&M input and a closing
contact for PA and GA events on the PAGA side should be connected to the same E&M input port
(ref.ch 1.12) and (ref. ch 3.2.1.3.1).

2.7.1 CREATE EMPA GROUP FOR TELEPHONE STATIONS
Create the EMPA group that will be used when distributing the PA/GA alarms and messages. This can
be done by clicking the ‘Groups’ menu and selecting ‘Add EMPA Group’.

Figure 2-115: Create EMPA group

Enter a name and select an unused extension number for it.
Add EMPA Group Wizard

Biasic Information

Eroup narne PAGA Group|

274 Group description

Extension number | 50 %

Figure 2-116: Enter group information
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Select the recipients of PA/GA messages and alarms. Note that only Phontech 61xx, 62xx and 72xx
stations are supported and high priority stations are not listed in the available list.
NOTE: An EMPA group has an overall priority in the system and will override any other actions, so

don’t select stations that should be usable during a PA/GA event.
Add EMPA Group Wizard

EMP# Destinations

Add the Classes, Users or Extensions this group should call.

3/4 Ausailable Members
v am Classes w ‘\ Users
Al Users 10 usersiz) S 105 Mess Hall
v & Users & 106 Cabin 1
S 103 Engine Roorn ‘ 107 Cahin 2
& 104 Warkshop & 108 Cabin 3
& 110 Captain & 109 Cabin 4

Figure 2-117: Select group members

Complete the wizard and locate the newly created group in the left hand extension list. Double click
on it or right click and select ‘Properties’.

Figure 2-118: Locate the new EMPA group

From the opened properties screen, select the ‘Skip Ding Dong before message’ checkbox to avoid a
duplicate ding dong when the PA/GA system already generates one. Click the Save button in the
bottom right to apply the changes and proceed to configure the PA/GA trunk line.

Basic Information Members Alert Source Access Control

This tab allows you to edit the name, extension and description of this group.

Mame |P.¢\Gn Group

Extension 50 (5

Skip Ding Dong befare message

[ Record message before playback

Descripkion

Figure 2-119: Disable Phontech 6200 generated Ding Dong
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2.7.2 ADDING THE TRUNK LINE CONNECTED TO THE PA/GA SYSTEM

Add an E&M trunk line for the PA/GA system, detailed information can be found in (ref ch 2.3.4.7).

Add Trunk Line

Please enter a name and a description For this trunk line.

Please enter a name and a description For this trunk line

2/9

Mame PAGS Connection|

Description

Figure 2-120: Adding a trunk line to the PA/GA system

Select E&M line type.
Add Trunk Line

Flease select the trunk line type.

Please select the type of trunk line you would like to add

) SIP Client
3/9
) SIP Serwer

7 FXO

Figure 2-121: Select line type

Select E&M port. This port will correspond with specific terminal on the terminal module (ref. ch

3.2.1.3.1)

Figure 2-122: Select E&M port
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Set Incoming action to Call an extension and select Line In Mode as EM Input Mode.
Add Trunk Line

Please choose the action to take when an incoming call is coming owver this trunk line.

Please select the desired action when an incoming call is arriving.

(®) Call an extension
5/9
[ Park incoming calls after the initial conversation with the called operator

() Switchboard
() Direct Inward Disling
() Disable incoming calls

EM Input Mode

(®) Line In Mode
() Microphane Mode

Figure 2-123: Select incoming call action

Select the group created in (ref ch 2.7.1) as the incoming call handler for the trunk line.

Figure 2-124: Select incoming destination

Disable the outgoing actions for this trunk line. Alternatively, a Dial Out Extension can be selected if
telephone stations should be allowed to send PA messages through the E&M interface and to the
PAGA system. This requires additional wiring of the E&M output as described in (ref ch 1.12) and (ref
ch 3.2.1.3.1).
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Add Trunk Line

Please choose how we should dial out over this trunk line,

Shaould dialing out over this trunk line be enabled?
779 () Prefix and dial out extension

() Decided by entered extension lenagth

() Dial out exkension only, no prefix number

® .m:isabled:;

Should billing information be tracked on this trunk line?

Mote: Biling not available as no call lagging unit has been configured. Do this under "ICS 6200 Storage Settings'.

No
Mo extra billing information is tracked on this trunk line.

Extension based
Users are identified by the phone they are using ta call the billed lines.
Users are automatically created From the configured user extensions,

Pin based
Users are identified by a pin they enter when they call a billed line.
The pins and users are configured From the call logging web interface,

Note:
Inkernal calls will only be tracked by the extensions that were used.

Enable pre-paid billing meters

Delay billing by 20 seconds

Figure 2-125: Disable outgoing actions

The setup should now be complete and the configuration should be sent to the Phontech 6200 units
by pressing the ‘Send Configuration’ button in the main screen.
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3 SYSTEM CABINETS/RACKS AND TYPICAL CONFIGURATIONS

3.1 CONFIGURATIONS FOR 6200
The basic cabinets for the Phontech 6200, ICS system configurations are a range of 4 different mini
rack sizes; 9U (4000018934ICS), 16U (4000019835ICS), 25U (4000018936ICS) and 34U
(4000018937ICS). A 34U combination rack for ICS and PAGA is also available (4000018937COM).
All cabinets/racks are based on the Schroff Novastar series, colour RAL7021 BlackGrey. All racks are
floor/desk mounted with cable entry from the bottom.
Each cabinet comes in either a AC primary / DC backup (AC/DC) or AC primary / AC backup (AC/AC)
power selection.

3.1.1 18934ICS, 9U PHONTECH SYSTEM CABINET

This 9U cabinet has a flexible configuration. Specific Layout drawings are available upon request
within the standard configurations. Each layout is further configurable within each Phontech 6200
module (24L (FXS/FXO/UpN/E&M) and 48IP (VoiP registrations):

Drawing No.: | Sequence No: | Max configuration
14848-001-ML | -01 72L/-IP

-02 48L /-IP

-03 24L/-IP

-04 48L / 241P

-05 241/ 48IP

-06 241/ 241p

-07 -L/ 48IP

-08 -L/24IP

Layout example (14848-001-ML-01), 3 pcs 6200; 72 Lines, 0 VolP.

Front View Side View

~)

456.00 sU I o0 R e =

S T Ty

S I T e e e L E

-~ H03. 00— - 600.00 -
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Layout example (14848-001-ML-04), 2 pcs 6200, 1 LAN Sw; 48 Lines, 24 VolP.

Front View

Side View

456.00

—~ 600.00——

Layout example (14848-001-ML-07) 1 pc 6200; O Lines, 48 VolP.

Front View

Side View

456.00

600.00——=

Top/Bottom View

419.

00

%a\ Terminal Plate Fg MOLmtIﬂg holes
]l_ AJ; to Desk aor Floor.

Area for cable

in/out 160.00
439, 00—
—38.00

; .
gu* Front 1%
-~ 51500
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Terminal arrangement and connection

AC/DC (14848-001-TA-01 / 14848-001-EC-01):

o ;
1 -
BHEE e
QEOE-L EC
i
OoO0] ﬁ%ﬁ
OO
Sreslie H i
QOO AL HEO0
OO [y
O_F_ w|o
_ D 0
Q
(]
OCl FE Ee H 1
O | = O
] Engmi—J .
ago =é§;ﬁ=:
u_aﬁ'_éﬁﬁ
o . R 5 =
oo IEE H H H
o He ©
@ o@E@EEADAAA®® @E@@@® O @A®®@®O @ |
QIO a6l GOl
ee ] He Sl
'A———“TA MY —:—[ -
INE /e == [ ]
N Ll g Y
L] s gz 8
C B BB | 10D

Power Foilure—=
220VAC (NO)—==

Power Failure—=
24VDC (NO)—==

AC/AC (14848-001-TA-02 / 14848-001-EC-02):
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NeuLteruE‘iJ
Live-
Neutral
Power Failure
230VAC (NO)

Power Failure
230VAC (NO)

For further connection details each system is supplied with a project dependent cable plan. This is
during production filled in with factory defaults and may be added further installation specific cable
details. See chapter 3.3 for details.
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3.1.2 4000018935ICS, 16U PHONTECH SYSTEM CABINET

This 16U cabinet has a flexible configuration. Specific Layout drawings are available upon request
within the standard configurations. Each layout is further configurable within each Phontech 6200
module (24L (FXS/FXO/UpN/E&M) and 48IP (VoiP registrations):

Drawing No.: Sequence | Max Drawing No.: Sequence Max
No: configuration No: configuration
14848-004-ML | -01 1441/ -IP 14848-004-ML -14 481/ 72IP
“ -02 120L/-IP “ -15 48L / 48IP
“ -03 96L/-IP “ -16 48L /241
== -04 72L/-IP 1= -17 241 / 961P
“ -05 48L/-IP “ -18 241/ 721P
- -06 24L/-IP - -19 241 / 48IP
“ -07 120L / 24P “ -20 241 / 241p
“ -08 96L / 48IP “ -21 -L/1201P
- -09 96L / 24P -- -22 -L/96IP
“ -10 72L/ 72IP “ -23 -L/72IP
“ -11 72L /48P “ -24 -L/48IP
- -12 72L /24P - -25 -L/24IP
“ -13 48L / 96IP
Layout example (14848-004-ML-01), 6 pcs 6200; 144 Lines, 0 VolP.
Front View Side View

\zz«,»i TR HE o

767.00 [

10U |

11U |

120 |

13U

14U |

15U |

16U |

_-—000.00——

Layout example (14848-004-ML-10), 3 pcs 6200, 3 Lan Sw; 72 Lines, 72 VolP.
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Side View

Front View

600.00

Layout example (14848-004-ML-21), 3 pcs 6200, 5 Lan Sw; 0 Lines, 120 VolP.

Side View

Front View

600.00

555.00———

p/n 4000087299 v.K

Page 3-99



Top /Bottom View

o
0o

Terminal Plate MDUﬂt\ﬂg holes

" to Desk or Flaor.

N

Area for cable

in/fout 160.00

419.00 r-—-—439,oo—..

_—$8.00

Front %

351 50.00—

iiwtiaio] NI N

p/n 4000087299 v.K

Page 3-100



Terminal arrangement and connection

AC/DC (14848-004-TA-01 / 14848-004-EC-01):

]
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m ] m[e]

Eald 1l | K2

(]|

L]

4 B35, 00
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QO wa @8
go oo 28 128
:::DD OO
:IEOO \E\DD [T ]
LRI s L f ] e
s =slik= = K aultt el
g H| 5
| LLIIE | HI=y=y 0l N =y~
s ol W i oE
QIR ] @a| | O®
) 88 | 33|
Neutral
+24V.
Dv-
Power Failure

220VAC (NO)

Power Failure
24VDC (NO)

AC/AC (14848-004-TA-02 / 14848-004-EC-02):

Gl @ €
SR || E—T |
:_T;OO_TQIOO I |l
L] %DD7 %DD %25%‘:: Sl S
o [AlEE e 4= 4= |
i 5 Nsgldlss
||| @
B I I P gy P
nn 0 | 0@
Livej @@ @
Neutral
Live
Neutral
Power Failure
230VAC (NO)
Power Failure

230VAC (NO)

For further connection details each system is supplied with a project dependent cable plan. This is
during production filled in with factory defaults and may be added further installation specific cable
details. See chapter 3.3 for details.
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3.1.3 18936ICS, 25U PHONTECH SYSTEM CABINET

This 25U cabinet has a flexible configuration. Specific Layout drawings are available upon request
within the standard configurations. Each layout is further configurable within each Phontech 6200
module (24L (FXS/FXO/UpN/E&M) and 48IP (VoiP registrations):

Drawing No.: Sequence | Max Drawing No.: Sequence Max
No: configuration No: configuration

14848-007-ML | -01 240L/ -IP 14848-007-ML -29 72L/ 1201P
- -02 216L/-IP - -30 72L / 96IP
“ -03 192L/-IP “ -31 72L/72IP
“ -04 168L/ -IP “ -32 72L/ 48IP
- -05 144L/-IP -- -33 72L/ 241pP
“ -06 120L/-IP “ -34 48L / 168IP
“ -07 96L/-IP “ -35 48L / 1441P
- -08 72L/-IP - -36 48L /1201P
“ -09 48L/-IP “ -37 48L / 96IP
“ -10 24L/-IP “ -38 48L/72IP
- -11 24L/-IP - -39 48L / 48IP
“ -12 192L/ 24P “ -40 48L / 241P
“ -13 168L / 48IP “ -41 241 / 168IP
-1 -14 168L/ 241P - -42 241 / 1441P
“ -15 144L/72IP “ -43 24L / 120IP
1= -16 144L / 48IP - -44 241 / 961P
1= -17 144L / 241P - -45 241/ 721P
“ -18 120L / 961P “ -46 241 / 48IP
1= -19 120L/ 72IP - -47 241 / 241P
1= -20 120L/ 48IP - -48 -L/1921P
“ -21 120L/ 241P “ -49 -L/ 168IP
1= -22 96L / 144IP - -50 -L/ 1441P
- -23 96L / 120IP - -51 -L/ 120IP
“ -24 96L / 96IP “ -52 -L/96IP
- -25 96L / 72IP - -53 -L/72IP
“ -26 96L / 48IP “ -54 -L/48IP
“ -27 96L / 24IP “ -55 -L /24P
- -28 721/ 1441P
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Layout example (14848-007-ML-01), 10 pcs 6200; 240 Lines, 0 VolP.

Layout example (14848-007-ML-18), 5 pcs 6200, 4 Lan Sw; 120 Lines, 96 VolP.

Front View

Front View

/.00

Side View

N

7.00

£00.00

Side View

=

553.00

600.00
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Layout example (14848-007-ML-48), 4 pcs 6200, 8 Lan Sw; 0 Lines, 192 VoIP.
Front View Side View

=)

SHE

THE

-~ 600.00———

Top/Bottom View

i

Terminal Plate E}é Moumting holes
T4  to Desk or Floor.

Area for coble

in/out 160.00

419.00 t-—459,00—-'

|_—68.00

I&iﬁr
i!f’?]?@]u"‘\

Front

~515.00——

Terminal arrangement and connection

AC/DC (14848-007-TA-01 / 14848-007-EC-01): See documents 14848-007-TA-01 and 14848-007-EC-
01

AC/AC (14848-007-TA-02 / 14848-007-EC-02): See documents 14848-007-TA-02 and 14848-007-EC-
02
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For further connection details each system is supplied with a project dependent cable plan. This is
during production filled in with factory defaults and may be added further installation specific cable
details. See chapter 3.3 for details.
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3.1.4 18937ICS, 34U PHONTECH SYSTEM CABINET
This 34U cabinet has a flexible configuration. Specific Layout drawings are available upon request
within the standard configurations. Each layout is further configurable within each Phontech 6200
module (24L (FXS/FXO/UpN/E&M) and 48IP (VoiP registrations):

Drawing No.: Sequence | Max Drawing No.: Sequence Max
No: configuration No: configuration
14848-007-ML | -01 312L/-IP 14848-007-ML -50 96L / 192IP
-02 288L/ -IP -51 96L / 168IP
“ -03 264L/ -IP “ -52 96L / 1441P
“ -04 240L/ -IP “ -53 96L / 120IP
-05 216L/-IP -54 96L / 96IP
“ -06 192L/-IP “ -55 96L / 72IP
“ -07 168L/ -IP “ -56 96L / 48IP
-08 144L/ -IP -57 96L / 241P
“ -09 120L/-IP “ -58 72L/ 216IP
“ -10 96L/-IP “ -59 72L/192IP
-11 72L/-IP -60 72L/ 168IP
“ -12 48L/-IP “ -61 72L / 1441
-13 24L/-IP -62 72L/1201P
-14 288L/ 24Ip -63 72L/ 96IP
“ -15 264L / 48IP “ -64 72L/721P
- -16 264L / 241P - -65 72L / 48IP
“ -17 240L/ 72IP “ -66 72L/ 241p
“ -18 240L / 48IP “ -67 48L / 2401P
- -19 240L / 241P - -68 48L / 2161P
“ -20 216L/ 96IP “ -69 48L / 1921P
“ -21 216L/ 72IP “ -70 48L / 168IP
- -22 216L / 48IP - -71 48L / 1441P
“ -23 216L/ 24IP “ -72 48L /1201P
“ -24 192L/120IP “ -73 48L / 96IP
- -25 192L/ 96IP - -74 48L/72IP
“ -26 192L/ 72IP “ -75 48L / 48IP
“ -27 192L / 48P “ -76 48L / 241P
- -28 192L/ 24P - -77 24L / 2401P
“ -29 168L / 1441P “ -78 241 / 216IP
“ -30 168L / 1201P “ -79 241/ 192IP
- -31 168L / 961P - -80 241 / 168IP
“ -32 168L/ 72IP “ -81 241 / 1441P
- -33 168L / 48IP - -82 241/ 120IP
“ -34 168L / 241P “ -83 241 / 961P
“ -35 144L / 168IP “ -84 241/ 72IP
- -36 144L / 1441P - -85 241 / 48P
“ -37 144L / 1201P “ -86 241 / 241p
“ -38 1441 / 961P “ -87 -L/264IP
- -39 1441/ 72IP - -88 -L/ 2401P
“ -40 1441 / 48IP “ -89 -L/216IP
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Drawing No.: Sequence | Max Drawing No.: Sequence Max
No: configuration No: configuration
14848-007-ML | -41 144L / 24P 14848-007-ML -90 -L/192IP
- -42 120L/ 192IP - -91 -L/ 168IP
“ -43 120L/ 168IP “ -92 -L/ 1441P
“ -44 120L / 1441P “ -93 -L/1201P
1= -45 120L/ 120IP - -94 -L/96IP
“ -46 120L / 961P “ -95 -L/721P
“ -47 120L/ 72IP “ -96 -L/48IP
- -48 120L/ 48IP - -97 -L/ 241pP
“ -49 120L / 241P
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Layout example (14848-010-ML-01), 13 pcs 6200; 312 Lines, 0 VolP.
Front View

Side View

&

1567.00 '

-—6(600.00——
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Layout example (14848-010-ML-35), 6 pcs 6200, 7 Lan Sw; 144 Lines, 168 VolP.

156

Front View

7.00

1U
2u
au
4U
=1
GU
U
8u
au
1ou
11U
120
13U
14U
15U
16U
17U
18U
19U
20U
21U
22U
23U
241
25U
26U
27U
28U
23U
3ou
31U
32U
33u
34U

"«%r‘_‘l"mm |
!%ﬁﬁﬁﬁ%

“I:I - EELT ST e
”Iﬂl - ERREEH ORE

-*wlﬂl - EEEE RO e
“Iﬁl - BRSO oo

ﬁﬁﬁﬁﬁﬁ
Ex °lﬁl - RS GOSN e

T EEECEE
[ eeali]
1

[IH LT

T EEER0NR
EEEEE EEREER

.

LR IE

= EEEE Ernin
5T EEERg0R

[IE 1L

22 BEEERg0R

11

0

05 3.00——

Side View

=

-~ H00.00——
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Layout example (14848-010-ML-87), 6 pcs 6200, 11 Lan Sw; 0 Lines, 264 VoIP.

Front View

156

7.00

Side View

74

-5 3. 00—

Top/Bottom View

=

Tarminal Plate

418.00

2

_ﬁ Maunting holes
y &K

Arso for cable
in fout

!

160.00

_—8.00

Front

e si5.00—— =

Terminal arrangement and connection

to Desk or Floor.

-6 00.00——

=
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AC/DC (14848-010-TA-01 / 14848-010-EC-01): See documents 14848-010-TA-01 and 14848-010-EC-
01
AC/AC (14848-010-TA-02 / 14848-010-EC-02): See documents 14848-010-TA-02 and 14848-010-EC-
02

For further connection details each system is supplied with a project dependent cable plan. This is
during production filled in with factory defaults and may be added further installation specific cable
details. See chapter 3.3 for details.

3.1.5 15U PABX/PA/GA COMBINATION ENCLOSURE
Three-part 15U wall-mounted enclosure. When combining the PABX with PA/GA equipment or amplifiers
this enclosure style is used. Solid top and cable entry brush insert at bottom.
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3.1.6 18937COM, 34U PHONTECH SYSTEM CABINET
This 34U cabinet is a dual functionality cabinet where one half contains the flexible configuration of
the 16U cabinet 4000018935ICS (see chapter 3.1.2). The other half contains an MPA1600 PAGA
system of up to 1440W output power into 6 zones. See MPA 1600 system documentation handbook

for details.
Frant View Inside Cobinet.

MPA—1600
14848-00%
16U

[CE5—B8200
14848-004
16L

BT T E T T T LI E R T TR T T e T T T T T TR T TR T T e T TR T T T T TR T LT T T T T T e e T T T e T T T T T E T T T e T T T T E T I TR T e T T T

- 553 -
Cabinet Depth: B00mm

Varlanis Mrawlnga:

1 4848—005—ML—M
14848—005—ML—-02
14848—005—ML—03
14648—005—ML—04
14848—005—ML—05
14848—005—ML—06
14848—-005—ML-07
14848—-005—ML—08
14848—005—ML—089
14848—-005—ML—10

. Drowings:
14848—-004—ML-O1
14848—004—ML—-02
14848—-004—ML—03
14848-004—-ML—04
14848—-004—ML—-05
14848-004—-ML-08
14848—004—ML-07
14848—-004—ML—0B
14845-004-ML-08
14548—004—ML—10
14848—004—ML—11
14848—-004—ML-12
14848—004—-ML-13
14B4B—004—ML—14
14848-004—-ML-15
14848—-004—ML—18
14848—-004—ML-17
14848—-004—ML-18
14848—-004—ML—13
14848—-004—ML—20
145485—004—ML—21
14848—-004—ML—22
14848—-004—ML—-23
142848 004—-ML—24
14848—-004—ML—25
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3.2 CONFIGURATIONS FOR 6200R

3.2.1 X-100278C, PHONTECH COMPACT CABINET

This 5U cabinet has a flexible configuration. Specific Layout drawings are available upon request
within the standard configurations. Each layout is further configurable within each Phontech 6200R

module (24L (FXS/FXO/UpN/E&M) and 23IP (VoiP registrations):

Drawing No.: | Sequence No: | Max configuration
100278C-ML -01 72L/-IP
- -02 48L / 23IP

It’s also possible to add Amplifier 1671 for PA-functionality and/or a Billing Unit 6202R in the
Compact Cabinet.

3.2.1.1 Layout example (100278C-ML-01), 3 pcs 6200R; 72 Lines, 0 VoIP

3.2.1.2 Layout example (100278C-ML-02), 2 pcs 6200R; 48 Lines, 23 VoIP

= & [
2 [ —
:EQ?E { /
=
=
J

e
)

i

S S e ——r
[y ey o

i
_l|

B

T = = = TT

|
=
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3.2.1.3 Terminal arrangement and connection

3.2.1.3.1 6200R Interface board
For easy connection, we recommend to use the 4000019813 interface board.

Actual Dsub numbering on termination board

Horizontal placed PCB

@- ''''''''''''''''''''''''' / |Term|nqt|or Hoard

e, q/‘ pcs for each 6200

p =\ | A

— T
all
\ S— —

BL00  Eear View

Interface board x-19813:
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FXS, FXO and UpN line board:

Port (x) — Line: A and B (Cand D not in use)

E/M line board:
The inputs are connected to odd-numbered ports, while outputs are connected the next even
numbered port. The audio is connected to lines A/B, while key is connected to lines C/D.

Port 1 —Audioin: Aand B
Key In: Cand D

Port 2 — Audio out: Aand B
Key out: Cand D

p/n 4000087299 v.K
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3.2.1.3.2 Power/Service/Loudspeaker Terminals

ICS §200 #1
LAN1

Live

Meutral

Blue

MNeutral 0R
Live 0=
Blue Ozl
Red OD’:

From 1671, P3 term. 1
From 1671, F3 term. 2

AC/DC version

L]

Power fail Frimary — 230VAC

1® 1@ 09]—21-22 (Ne)
03 0E O@[—11-14 (NO)
_ K2
Power fail Secondary — 24VDC
0O 0® D®F-21-22 (Nc)
0 0@ OSf—11-14 (NO)
T8
o0 GO e
I Z ] LI Live
[ (=10
r}_ L ane
= ld 230VAC | t
LA ENETIS Neutrl F'imuury e
LA 1L
0 0 ()
I ; U': HEIER ;. GND
o0 o0 s [0
TB2
+24V
- s .
Py e
o0 2 [[I[OO] |
F=—+——Fuse 5 AT
| — Fuse 5 AT
—Fuse 5 AT
24vDC
Second
OFov
[¢] OC J—ev
0o
O Fuse 5 AT
(SR -Fuse 5 AT
e Fuse 5 AT

O0 OO0 0000 00—
OO0 OO0 00 =00

o

Oo Oo =00

100% to lsudspeakers

ICS 6200 #1
LANT

From 1871, P3 term. 2

AC/AC version

]

Power fail Primary — 230VAC

NL'..J{’HH 1 O 0% 02 0@ |—21-22 (NC)
Live 1 0 0% 02 D@|—11-14 (NC)
o kK2
Fower fail Secondary — 230VAC
Neutral 2 [ 1D 1D 09—2-22 (\)
Live 2 o 08 02 DE—11-14 (NO)
Live 1 187
OnEYN 1 0C
()— ) 2 | 0 b—tive
o0 O 10
Heutral 1
@IESmIN RIS .
[ [N 5 :"’) Neutral ;3.0“'“: Input
< ES — rimary
0 ] [
0 (0] 0C)
o0 (L [IC_J—sno
@iEelm e
Live #
SO 0
o0 OO 2 | OC J—+tie
o0 OO N[
Mewtral 2
o0 0 + 100D .
(@] [@)] 5 Q —Neutral | 230WAC Input
= o = Secendary
nput OO O s 1000
ry
OO ne)
een 5 | (=5
SIEGRINRIERII®
From 16871, P3 term. 1

100V to loudspeakers

3.2.1.3.3 1671 Amplifier - Electrical connection

HESGND ~ A
4 P2 W BIE @ - y . ”‘[,.' ., )
] P3 1 Y Y o
| T | T/ e
To T8 |
I erminatior ]
opph |
DCEB A the | \
\udic | I, 0. ‘l.—‘ 24 llect from fused
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3.2.1.3.4 6202R Billing Unit - Electrical connection

S A200 Central (Last one) Rear View

LANT LANZ

=)
o]

ellow (GN
Brown  (Live)

3.2.1.3.5 7200 PoE Lan Switch - Electrical connection

7200 PoE LAN SWITCH 7200 Rear View DC

ICS 6200/6202 Rear View

2 LANT  LAN2
TN
|

7200 Front View
4 6 8 10 12 1416 18 30~ 7
{

T P
Y.

7 8 1 1718 21 23§

Port 1 — 23: 1:1 patch to Terminal Board through Cable Organizer 9040

Interface board 4000019812

Termination:

Port (x) 1- White/Orange
2- Orange
3- White/Green
4- Blue
5- White/Blue
6- Green
7- White/Brown
8- Brown

White (0V}
Secondary ¢ Groen (GND}
Brown (24V

e (Neutral)
—Green /Yellow (GND)
7200 Regr View AC [orown (Live)

7B
7’

} Primary

181 woy 1931103
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3.3 PROJECT DEPENDANT CABLE PLAN

Together will all new Phontech 6200 systems, a USB memory stick is attached. This contains all
necessary handbooks together with a project dependent Cable plan.
FXS/UpN/FXO/E&M Cable detail plan:

— 100 1 — = —_
— 100 i = =
1 - = 102 i = =
= i T = _ =
= i) T1 = =
= 6 1 = =
2 - — e 11 — —
= 107 1 = =
— 108 T1 = =
= 108 T = =
3 - = 10 T = =
1 = 1id 1 = _ =
- 12 1 = =
— fSE] 1 = =
4 - = 114 1 = =
= 1iE i = =
= 18 Tl = =
= 17 T = =
e - = 118 1 — —
= 18 1 = _ =
= 120 Tl = =
— 151 i = =
& - = 1323 i = =
= ] T p —
= 124 Tl 1 = =
— g 1 — —
1 - — 125 L1 — —
= &7 1 = _ =
= 128 Tl = =
= 135 i = =
2 - = 130 =1 — —
= 5 5! = —
= = T1 — —
= fEE 1 = =

3 - -
= fEX] 1 = -
2 = 135 i = _ =
— [E T1 p —
— i i = -
4 - — 138 11 — —
= i 1 = =
— 140 Tl = =
= 181 1 = =
5 - — 143 i1 — —
= i T — —
= 100 T1 = =
— 145 1 = =
& - — 136 1 — —
= i T1 = =
= 118 Tl — = =
— 188 i = =
1 - — 150 T = =
= 154 T = _ =
— 52 T1 = =
= 152 1 = =
z - = LX) i1 — —
= fES 1 = =
= 158 Tl — —
= 157 i = =
3 - — 158 =1 — —
3 = 55 5! = _ =
= 160 T1 = =
= 181 1 = =
4 - — 18 i1 — —
= = i = =
— i) T1 = =
— i i = =
3 - — 166 11 — —
= i85 1 = _ =
— 158 Tl = =
= ) 1 = =
& - — 170 L1 — —
= T T = =
— 172 T1 2 — —
= i T = =
1 - = 7 1 — —
= s 1 = _ =

And so on.
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VolP Cable detail plan:

Patch Panel

ICS Mo.: Ext.Mo: Switch port: termination: Port: Field Cable:
100 1 11 -— -
10 2 11 -
102 3 1:1 =
103 4 1:1 =
104 5 1:1 =
105 -] 11 =
106 7 11 =
107 B 11 =
108 ] 1:1 =
100 10 1:1 =
110 11 11 =
111 12 11 =
112 13 11 1 -
113 14 11 =
114 15 11 =
115 16 11 -
116 17 11 -
117 18 11 =
118 19 11 =
115 20 11 -
120 21 11 -
121 22 1:1 =
122 23 1:1 =

1 123 24 11 =
124 1 11 =
125 2 11 =
126 3 11 =
137 4 11 =
128 5 11 =
129 B 11 =
130 7 11 =
131 g 1:1 =
132 ) 1:1 =
133 10 11 =
134 11 11 -
135 12 1:1 -
136 13 11 P -
137 14 1:1 =
138 15 11 -
135 16 11 -
140 17 1:1 =
141 18 1:1 =
142 19 11 ==
143 20 11 ==
144 21 11 =
145 22 11 =
146 23 1:1 ==
147 24 11 ==
148 1 1:1 =
149 2 11 =
150 3 11 =
151 4 11 =
152 5 11 =
153 B 11 =

And so on.
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4 INTERCOM UNITS

4.1 FIRST GENERATION INTERCOM UNITS
611161126113 61146123 6124

4.1.1 GENERAL CONFIGURATION INFORMATION

All intercom units (Phontech 6111, 6112, 6113, 6114, 6123 and 6124) are equipped with an internal
DIP-Switch block containing 8 switches. These configure some individual settings for each unit:

DIP Sw Description
1 Activate Backlight DIMMER function in the Phontech 6123

For future use

For future use

Disable OFF HOOK sensor (ACT key is the only way to activate the unit)
For future use

For future use

For future use

For future use

0 INd|OO LB WIN
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4.1.2 PHONTECH 6110 MKII, ACCOMODATION UNIT

Y

Phontech 6110 MK

..

<)

- Built- in WP loudspeaker.

- Hands free, duplex communication.

- Privacy switch.

- Telecom standard alphanumeric keypad.

- Manual PTT (push-to-talk) key.

- ACT key. (line active)

- 3 direct access programmable keys. (M1-M2-M3)
- 10 pcs. accessible programmable keys. (0-9)

- Volume control key (VOL) with override (important message priority)
- Program key. (P)

- Connection: One Pair —line feed

- Desk or bulkhead mounted.

Operation voltage 37VDC provided by line

Current drain 70 mA max, provided by line
Sound pressure level 80dBA@1m typical
Weight 1.0kg

External connections Phontech 6110 Mkl
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(De2e3 0
tde9E0 Q
)08 e9 o

CONNECTION BOX

CONNECTION BOX |Wall Mounted

Flush Mounted

LINE CONNECTION TO DICS

EXCHANGE 610X =

Term. 4
Term. 5

2 CENTER CORES

1073 rI R3 © 6
28§72 K R2Z@ S
& Q‘F'q%
3IQR M@4

LINE CONNECTION TO DICS

EXCHANGE 610X = 2 CENTER CORES

— RED / GREEN
- Rl /T
-3/ 4
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4.1.3 PHONTECH 6111, WP UNIT WITH HANDSET

Py

gt

= Pl Pl
i y ',
,-""‘.H\'i‘ ! ommp- ) { aum - "I
WA y Pg f hoAuc |
‘:._.j — __.z)l '\.\ fJ
-
\;\x 4 \ .!'Vf \\
~" ‘\ 6/ W - S ‘_,-*
*-\-._,--‘, o AR ToR g.m FTE
LIKE LoD

WOUHTHG HOLES 11200 J

HLET FOR
HAMGEET

e

=1 J.rl') FI'RA‘“r

NS0 00

~— |

\ 1 A
:c-.\ f | /":" PeonTECH{ETIE] 1 1
N L

4 1 L
T (= e
l, ! I
e - P
OOO®@ ||
.
1 | 0D L
(i
h ) ;I
‘ .... e
7

Bulkhead mounted.

Output for external loudspeaker.

Hands free (requiring external loudspeaker), duplex communication.
Telecom standard alphanumeric keypad.

Rugged handset of WP type.

Manual PTT (push-to-talk) key.

ACT key. (line active)

Direct access programmable keys. (M1-M2-M3)

10 pcs. accessible programmable keys. (0-9)
Volume control key (VOL) with override (important message priority)
Program key. (P)

Call signal relay. (For external signal organ, flashlight, siren etc.)
Connection:

0 Handset only: One Pair — line feed connection
0 External loudspeaker or relay for external signal device: Line + 24V DC
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Operation voltage 37VDC provided by line
Current drain

External loudspeaker and relay function requires an additional power input.

Power requirement, additional input
1A/24VDC
External loudspeaker:
Max power 10W
Impedance 20 ohms
External signal organ current capabilities:
24 VDC: max. 5A
115 VAC: max. 6,3A
220 VAC: max. 5A
Weight 1.0kg.
Ingress protection IP 56

4.1.4 PHONTECH 6112 WEATHERPROOF UNIT

-

PANt il
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GLANE FO

— ——
o r'f Y i B
i k] { Bur- |' uwo- |
el b TR ET
gl e f R

R p—

{ Vo O b

' __)/,r i\\.__z’; L

e GLAKD VO GLAKL ":J.“ EX
I USRS SR

WMOUNTIRG HILES 11B.00 = J
1 50,0

@.

70 mA max, provided by line
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- Bulkhead mounted.

- For external loudspeaker.

- Hands free (requiring external loudspeaker), duplex communication.
- Telecom standard alphanumeric keypad.

- Manual PTT (push-to-talk) key.

- ACT key. (line active)

- Three direct access programmable keys. (M1-M2-M3)

- 10 accessible programmable keys. (0-9)

- Volume control key (VOL) with override (important message priority)
- Program key. (P)

- Call signal relay. (For external signal organ, flashlight, siren etc.)

- Connection:
0 Line
0 24V DC

Operation voltage 37VDC provided by line
Current drain 70 mA max, provided by line

External loudspeaker and relay function requires an additional power input.

Power requirement, additional input
1A/24VDC
External loudspeaker:
Max power 10W
Impedance 20 ohms

External signal organ current capabilities:
24 VDC: max. 5A
115 VAC: max. 6,3A
220 VAC: max. 5A
Weight 1.0 kg.
Ingress protection [P 56
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External connections Phontech 6111/6112

CONMECTION TO
MICS EXCHANGE
G610

24 VDC POWER SUPPLY
FOR EXTERNAL LOUD-
SFEAKER AMD RELAY

DICS 6112 WP UNIT

228
@ 28 LME
@ 30 SCREEN [ GND

e - — LOUDSPEAKER
EXTERNAL I.OUDSPEM(ERLDE [ :I_:’" Typ. 20 Ohms
SCREEM / GND 11 {a—T Mox. 154
BLACK
1
:.':htz:-J MIC
HEADSET Mic |2_,@ YELLOW Cj]
247N
HEADSET EAR | 250 ]
HOOKSWTCH |25@ | EAR
FOR HEADSET| 276 "
| 2
b=
o o
RED =
WHITE EAR | E
0N—HDCIK+
BROWN 7 HOOK—
- SWITCH
GREEN OFF HDDK+ L‘

PRESET

RGE«

LEVEL FOR
THE EXTERMAL LOUDSPEAKER

SIGMAL DEVICE FOWER SUPFPLY
24¥0C / 11OVAC / 230VAC

INTERMAL MAX 5A
CONNECTION: I
15 (+]) —
[ 20 _/ SIGNAL DEVICE
EXTERMAL (+)
SIGHAL I 7 [
DEVICE 43 .
S| noT IN USE
[_ INTERMAL ALTERMATIVE COMMECTION: —|
COMHECTION:
| | 1 ND |
EXTERMAL 2| NOT IN USE GENERAL
| SIGMAL 3E COM| SENSOR
DEMICE 4| NOT IN USE SYSTEM
5&

P4
@6 +24 VOO

@7 av
28 SCREEM / GND

NOTE 1:

SW 1 OFF = HOOWKSWTCH DETECTION ENABLE
SW 2—4 EXTERMAL MIC. SENSITIMITY ADJUSTMENT:

sW 2 [sw 3 [sw 4 |sEnsTETY

oN | ow | on 0d8  |{DEFAULT}
OW | OFF | OFF -3 dB

OFF | oM | ON - dB

OFF | oM | OFF -9 dB

OFF | OFF | ON | —12 dB

QFF | OFF | OFF -15 dB
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4.1.5 PHONTECH 6113 AND 6123 FLUSHMOUNTING UNIT
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- Flush-mounting.
- Built-in WP loudspeaker.
- Output for external loudspeaker.
- Hands free, duplex communication.
- Telecom standard alphanumeric keypad.
- Manual PTT (push-to-talk) key.
- ACT key. (line active)
- Three direct access programmable keys. (M1-M2-M3)
- 10 accessible programmable keys. (0-9)
- Volume control key (VOL) with override (important message priority)
- Program key. (P)
- Call signal relay. (for external signal organ, flashlight, siren etc.)
- Phontech 6123 only; backlighting with dimmer.
- Connections:
0 Handset only: One Pair — line feed connection
0 External loudspeaker or relay for external signal device: Line + 24V DC
0 Phontech 6123 Backlight: Line + 24V DC

Operation voltage 37VDC provided by line
Current drain 70 mA max, provided by line
Sound pressure level 80dBA@1m typical
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Backlight dimmer 5 steps : 10mLux — 1 Lux

External loudspeaker and relay function requires an additional power input.

Power requirement, additional input

1A/24VDC

External loudspeaker:

Max power 10W

Impedance 20 ohms

External signal organ current capabilities:
24 VDC: max. 5A
115 VAC: max. 6,3A
220 VAC: max. 5A

Weight 1.5 kg.

Ingress protection IP 44

External connections Phontech 6113/6123

DICS 6113 FLUSHMOUNTING UNIT
(wo. BACKLIGHT)

LOUDSPEAKER
28 ]

CONNECTION TO @ |LINE EXTERNAL LCIUDSF'EAKER| { ]i / | Typ. 20 Ohms
DICS EXCHANGE ||@29 10& 7= Max. 15W
610X @ 30 SCREEN / GND SCREEM / GND 11 &H '

SIGNAL DEVICE POWER SUPPLY
24WDC / 1MOVAC / 230VAC

MAX 5A
INTERNAL
CONNECTION: (
[ 1o SIGNAL DEVICE
|
EXTERNAL 2015
SIGNAL 3 / (
DEVICE FYe _
5@| NOT IN USE
ALTERNATIVE CONMECTION:
INTERNAL
CONNECTION:
| 1@ NO
EXTERNAL 2@ NOT IN USE GEMERAL
SIGNAL 3D COM| SENSOR
DEVICE 4@| MoT N USE SYSTEM
5 NE

@6 +24 vDC
@7 ov
@8 SCREEN / GND

24 VDC POWER SUPPLY
FOR EXTERMNAL
LOUDSPEAKER
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4.1.6 PHONTECH 6114 WP PORTABLE UNIT

125,00 fr—41.50——=

F/ ) B ]

===========

S

J :

QOO

238.00

10metar CABLE
AND PLUG

TO BE COMMECTED
TO PLUE BOX 3011

- Built-in WP loudspeaker.

- Internal microphone.

- Duplex communication.

- Telecom standard alphanumeric keypad.

- 10 m. cable and connector.

- Manual PTT (push-to-talk) key.

- ACT key. (line active)

- Three direct access programmable keys. (M1-M2-M3)
- 10 accessible programmable keys. (0-9)

- Volume control key (VOL) with override (important message priority)
- Program key. (P)

- Connection: Pluggable one pair — line feed

- Bulkhead mounting.

Operation voltage 37VDC provided by line

Current drain 70 mA max, provided by line
Weight 1.5 kg.
Ingress protection IP 56

p/n 4000087299 v.K



4.1.7 PHONTECH 6124 WP BULKHEAD UNIT

150,00 4.3 50

140,00

T |
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Built-in WP loudspeaker.

Internal microphone.

Duplex communication.

Telecom standard alphanumeric keypad.

10 m. cable and connector.

Manual PTT (push-to-talk) key.

ACT key. (line active)

Three direct access programmable keys. (M1-M2-M3)
10 accessible programmable keys. (0-9)

Volume control key (VOL) with override (important message priority)
Program key. (P)

Connection: Pluggable one pair — line feed

Bulkhead mounting

Operation voltage 37VDC provided by line

Current drain 70 mA max, provided by line
Weight 1.5 kg.
Ingress protection IP 56
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4.1.8 TYPE 9011 PLUGBOX (FOR PHONTECH 6114)

T4, 0
130.00 52.00
| 1
I =
© ~©
PHOMTECH BOI1 ﬂ:
3
Mic/ 8
HEADSET —
. 124,00
@ﬂ/_

WITH CAPSULE. E—
LINE IM

- Receptacle with cover.
- Rugged plastic box.
- Bulkhead mounting

Weight 0.3Kg
Ingress protection IP 56

p/n 4000087299 v.K

Page 4-133



External connections Phontech 6114 and 9011

DICS 6114 WP PORTABLE UNIT

|n] g; LINE
T—@ 3 SCREEN / GND

5m
9011, PLUGBOX
T @1 | CONNECTION TO
Y 3 &2 | DICS EXCHANGE
bl @3 | 610%
L S W1
PLUG
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4.2 SECOND GENERATION INTERCOM UNITS
62106211 6212 6223 7210 7211 7212 7223

4.2.1 PHONTECH 6210, ACCOMODATION UNIT, TWO WIRE
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4.2,2 PHONTECH 6211, WP UNIT W/HANDSET, TWO WIRE
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EXTERNAL CONNECTIONS

Terminal board: Main module terminations:
- A . (IJFQ?!WVEE:C) Expansion Headset Conermet Ethg‘;rEletl
SO el A ¢ :
tﬁ/ [Ri2| [Rn2] [Ri4s] [Rias
PC Net

Internal connections:

12 —RI12 (Expansions/Headset)

Optional External connection
RJ45 — Ethernet/PoE (net)
RJ45 — Ethernet (PC)

P1.1 — External signal device Relay NO P2.1 — External Loudspeaker +

P1.2/3 — PE (Protective Earth) P2.2 — Screen

P1.4/6 — Common VIA point P2.3 — External Loudspeaker —

P1.5 — External signal device Relay Com P2.4/5 —+24V DC Power supply (amplifier/relay)
P2.6/7 — OV DC Power supply (amplifier/relay)

P3.1 — Headset Earphone L Ref P2.8/9 - UpN two-wire line

P3.2 — Headset Earphone L P2.10 - Screen

P3.3 — Headset mic. +

P3.4 — Headset mic. - P4.1 — Expansion CAN Hi

P3.5 — Headset Earphone R P4.2 — Expansion 3.3V

P3.6 — Headset Earphone R Ref P4.3 — Expansion GND

P3.7 — Headset PTT P4.4 — Expansion CAN Lo

P3.8 — Headset PTT Ref
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4.2.3 PHONTECH 6212, WP UNIT WO/HANDSET, TWO WIRE
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EXTERNAL CONNECTIONS

Terminal board:

P1.1 - External signal device Relay NO
P1.2/3 — PE (Protective Earth)

P1.4/6 — Common VIA point

P1.5 — External signal device Relay Com

P3.1 — Headset Earphone L Ref
P3.2 — Headset Earphone L
P3.3 — Headset mic. +

P3.4 — Headset mic. -

P3.5 — Headset Earphone R
P3.6 — Headset Earphone R Ref
P3.7 — Headset PTT

P3.8 — Headset PTT Ref

AL ’}3/"' F‘_El ‘ﬁ,_]'iﬂ |E'J_4‘§| |ﬁ'l:§]
PC

Main module terminations:

Ethernet  Ethernet/

Power
L (uzavpg) Expansion  Headset PoE

Net

Internal connections:

Optional External connection
RJ45 — Ethernet/PoE (net)
RJ45 — Ethernet (PC)

P2.1 — External Loudspeaker +

P2.2 —Screen

P2.3 — External Loudspeaker —

P2.4/5 —+24V DC Power supply (amplifier/relay)
P2.6/7 — 0V DC Power supply (amplifier/relay)
P2.8/9 - UpN two-wire line

P2.10 — Screen

P4.1 — Expansion CAN Hi
P4.2 — Expansion 3.3V
P4.3 — Expansion GND
P4.4 — Expansion CAN Lo
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4.2.4 PHONTECH 6223, CONSOLE MOUNTED UNIT, TWO WIRE
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CONSOLE UNMOUNTING INSTRUCTIONS
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EXTERNAL CONNECTIONS

Terminal board:

P1.1 — External signal device Relay NO
P1.2/3 — PE (Protective Earth)

P1.4/6 — Common VIA point

P1.5 — External signal device Relay Com

P3.1 — Headset Earphone L Ref
P3.2 — Headset Earphone L
P3.3 — Headset mic. +

P3.4 — Headset mic. -

P3.5 — Headset Earphone R
P3.6 — Headset Earphone R Ref
P3.7 — Headset PTT

P3.8 —Headset PTT Ref

Main module terminations:

. [unggt) Exponsion  Headset Etherngt EthFe";lgetf
Y i

}9/ [Ri2| [rRn2] [Rias| [rias

PC Net

Internal connections:

Optional External connection
RJ45 — Ethernet/PoE (net)
RJ45 — Ethernet (PC)

P2.1 — External Loudspeaker +

P2.2 —Screen

P2.3 — External Loudspeaker —

P2.4/5 —+24V DC Power supply (amplifier/relay)
P2.6/7 — OV DC Power supply (amplifier/relay)
P2.8/9 - UpN two-wire line

P2.10— Screen

P4.1 — Expansion CAN Hi
P4.2 — Expansion 3.3V
P4.3 — Expansion GND
P4.4 — Expansion CAN Lo
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4.2.5 PHONTECH 7210, ACCOMODATION UNIT, VOIP
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4.2.,6 PHONTECH 7211, WP UNIT W/HANDSET, VOIP
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4.2,7 PHONTECH 7212, WP UNIT WO/HANDSET, VOIP
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4.2.8 PHONTECH 7223, CONSOLE MOUNTED UNIT, VOIP
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CONSOLE UNMOUNTING INSTRUCTIONS
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4.3 TYPE 6035 HEADSET WITH HOOKSWITCH

] -

10m CABLE
For use with 5111-H, 6112, 6211, 6212, 6223, 7211, 7212 and 7223

- High comfort headset with boom microphone and hook-switch.

- Excellent attenuation at low and high frequencies with maximum comfort for continuous
use.

- ldeal in severe noise environments.

- Folds to compact size for easy storage.
- 10 m. cable. (optional 15m)

- Noise cancelling microphone.

p/n 4000087299 v.K
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5 ANALOG TELEPHONES
5.1 GIGASET DA710

- Dimensions (approx.):
0 221x202x62mm (LxWxD)
- Weight: 0.9Kg
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5.2 PHONTECH 5113/5123 FLUSHMOUNTING TELEPHONE
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- DTMF analogue telephone

- Loudspeaking/handset operation

- 3 Speed dial keys

- Relay for external signal device Max 5A

- Ext. loudspeaker connection

- Console flush mounting

- |IEC 60945 Approved

- 5123 only: Backlight /dimmer control

Weight: 1.2 Kg
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5.3 PHONTECH 5111 RUGGED INDUSTRIAL TYPE TELEPHONE

- Housing: Polycarbonate / Colour: Black

- Handset retaining mechanism

- Protection degree: IP65/IEC 529

- Receiver volume can be boosted by 6 or 12 dB(A)
- Ringer output: approx. 96 dB(A) at 1 m distance
- Temperature range: -25°C up to +60°C

- Desktop or bulkhead mounting

Weight: 1.7 Kg
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5.4 PHONTECH 5111-H RUGGED INDUSTRIAL TYPE TELEPHONE WITH

HEADSET INTERFACE
]
—r
] | —

r
£
g

HEADSET 603
FOWER 24VD—m
ANALOG PABX LINE

- Housing: Polycarbonate / Colour: Black

- Handset retaining mechanism

- Protection degree: IP65/IEC 529

- Receiver volume can be boosted by 6 or 12 dB(A)
- Ringer output: approx. 96 dB(A) at 1 m distance
- Temperature range: -25°C up to +60°C

- Desktop or bulkhead mounting

- Connection for 6035 headset

- 24VDC power supply required

Weight: 1.7 Kg
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5.5 EXRESISTTEL TELEPHONE FOR HAZARDOUS AREAS

2EE.00

iy - @

CAELE INLET |
M20 = 1.5

Weight: 5.7 Kg

Bulkhead mounting

- Types of protection:
O I12GEExeml[ib] ICT5 /112D IP66 T100°C / -25°C<=Ta<=60°C
O I12GEExeml[ib] ICT6 /112D IP66 T80°C/ -25°C<=Ta<=40°C

- Housing Glass fibre reinforced polyester

- Certified for dust and gas atmospheres

- Display 2 lines; alphanumerical / multiple languages

- Telephone directory

- Hands free operation

- Impact protection IK 09

- Integrated adjustable stabilizer bracket

- Operations temperature -25°C to +60°C

- Adjustable receiver volume (7 steps)

- Max audio level approx. 90 dB(A)

- Stainless steel (V4A) keypad and steel armored handset cord with snap-protection
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6 IP TELEPHONES
6.1 SNOM 300

App. 188.00

=)

| oo
OO®®

|

=
Basic office IP telephone
- Two line display
- Caller ID (Name / Number)
- Programmable function keys
- Hands free operation
- 2 Eth ports (internal switch)
- PoE / External supply
- SIP Client

- Headset connection
- Intercom operation

App. 205.00 ‘

Weight: 1.0Kg
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6.2 SNOM 710

Basic office IP telephone

- Backlit graphical display, 4 lines

- Dual-angle footstand: 46° and 28°

- Wall mountable

- Hands-free talking (speakerphone)

- Digital Signal Processor (DSP) enhanced audio quality

- 2-port 10/100 Mbps Ethernet switch (RJ45)

- Power over Ethernet IEEE 802.3af, Class 1

- Electronic Hook Switch (EHS) support for wireless headsets
- Intercom operation

Dimensions (approx.):

O 205 x 185 x 40 mm (LxWxD) w/o footstand

O 205 x 185 x200/220 mm (LxWxD) with footstand
Weight: 0.6 Kg
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6.3 FERNTEL IP

FernTe p

Industrial Phone for Indoor and Outdoor Environments, IP 65
- Display

- Caller ID (Name / Number)

- Caller ID (Name / Number)

- SIP client

- Desk / Wall mounting

- PoE / External supply

- Optional: available as Ex approved type (Zone 2/22)

Dimensions (approx.): 293 x 191 x 128 mm (HxWxD)
Weight: 2.3Kg
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6.4 RESISTTEL IPZ

EhS i
Industrial Phone for Indoor and Outdoor Environments, IP 66
- Display
- SIP client
- Hands free operation
- 2 Eth ports (internal switch)
- Desk / Wall mounting
- PoE/ External supply
- Optional Relay output

Dimensions (approx.): 293 x 227 x 135 mm (HxWxD)
Weight: 5.0Kg
Temperature: -40°Cto + 70°C
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7 NETWORKING EQUIPMENT
7.1 PHONTECH 7200

- 482,68 -
1
Qyrowen O
o- @) - <
O <
Pyl isi ) PHONTICH TRE F
oL
o
A T i @.—- = = o = — i
® ®
©] @ C]
10 2
~ ® ® n
m° | | °
C T '
y Tl (e Wy

The Phontech 7200 LAN switch includes 24 Gb Ethernet and 2Gb SFP ports for fiber connectivity. 26

ports in total. The switch is fully manageable through the Web and Command line interface.

- 24 Ethernet ports

- 2 SFP Gb ports

- PoE, 24 ports

- Dual power supply
- IEC 60945 approved

Weight: 3.9Kg
Temperature: -15°Cto + 55°C
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7.2 SF-300
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24 port Ethernet switch with PoE

The SF-300 Ethernet switch with Power over Ethernet is required for the connection of IP telephones.
Connect the IP telephones to the SF-300 switch using Cat5e patch panels. The SF-300 is in turn
connected to the Phontech 6200’s Ethernet connection. Power is supplied from the switch to the IP
telephones over the Ethernet cable.
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8 ACCESSORIES

8.1 50 PORT TELEPHONY PATCH PANEL

The 50 port Cat3 patch panel can be used when connecting FXS, FXO, UPN and E&M lines to the
Phontech 6200 when structured cabling is used in the installation. This drawer style patch panel

allows for easy access during termination of the field cable.
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8.2 24 PORT CATS5E PATCH PANEL

The 24 port Cat5e patch panel is intended to be used for Ethernet lines, but may also be used for FXS,
FXO, UPN and E&M lines.
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8.3 620548 PORT PATCH PANEL FOR SHIPS CABLE.

The Phontech 6200 is primarily designed for use with structured cabling. When using traditional ships
cable, the 6205 patch panel is used together with the termination module. The patch panel is
connected to the termination module using a 25 pin DSUB cable.
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8.4 Y-CABLE FOR 6205 PATCH PANEL

When using this patch panel in combination with the E&M line board, and the keying inputs
or outputs are used, a special Y-patch cable is required, Zenitel item no: 4000018472.

The black RJ-45 jack is connected to the E&M port on the Phontech 6200 unit, the red RJ-45 jack is
the audio line and the yellow RJ-45 jack is the key 10. The red and yellow jack is inserted in the 6205
patch panel at the desired locations.
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8.5 PHONTECH 6216 EMERGENCY PA UNIT

Key Features
e Noise cancelling / Close talk gooseneck microphone

e Emergency PA activation button
e Protection against unintended use: sliding cover

Dimensions:
144 x 96 x 83 mm (LxWxD
Microphone height: 360 mm
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